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Chapter 1. Troubleshooting Guide

This guide describes how to analyze and resolve some of the common problems that you might 

encounter while you work with Rational®  Performance Tester.

Troubleshooting performance testing
This topic provides information about how to troubleshoot several problems with IBM®  Rational® 

Performance Tester.

If you run tests and encounter problems, make sure that you have followed all the Performance testing 

tips  on page .

If an error message is displayed when you run tests, try looking up the error message in the Performance 

testing error messages  section of the online help. Only the most common error messages are listed. If no 

error message is displayed when you encounter a problem, open the error log by clicking Window  > Show 

View  > Error Log. If the workbench shuts down while running tests, restart the workbench and examine 

the error log. By default, warning and error messages are logged. You can increase the default logging 

level by clicking Window  > Preferences  > Logging. The log file is stored in the .metadata  directory of 

your workspace. To avoid excessive logging, the Logging Level should be adjusted for individual Logger 

Names in the Loggers tab. For example, to get more information about a problem connecting with IBM® 

Rational®  Quality Manager, increase the Logging Level for com.ibm.rational.test.lt.rqm.adapter Logger 

Name. For the licensing issue, adjust the level for com.ibm.rational.test.lt.licening Logger Name. When 

you no longer need the extra logging, use the Restore Default  button in the Logging Preferences to reset 

all the levels to their recommended defaults.

In addition to the online help, you can find workarounds or solutions to problems in the Rational® 

Performance Testing forum  on developerWorks®, and in the Support Knowledge Base technotes  for 

Rational®  Performance Tester.

You might encounter some of these problems while performance testing:

Connectivity problems between workbench and agent computers

If the workbench stops or locks up when you attempt to start running tests, it is important to confirm that 

all the agent computers are running. Perform the following steps to confirm your installation is properly 

configured:
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• Confirm that there is sufficient disk space available on the workbench computer and the agent 

computers.

• Restart the workbench computer.

• Verify the network connectivity between the workbench computer and agent computers. To 

confirm the hostname in majordomo.config file can be DNS resolved on the agent machine, use a 

shell ping to the workbench hostname. If the ping results fail use the IP address of the workbench 

instead.

• Confirm the server port number on the test workbench computer. Click Window  > Preferences 

> Server. This is the port number that should be specified in majordomo.config file on the agent 

machines.

• Restart the agent computers and verify the Majordomo process is running.

• On the agent machines, set the optional debug flag in the majordomo.config file. Set the value 

equal to true; the default value is false. You do not have to restart the agent. Within about ten 

seconds it should automatically pick up the changes to majordomo.config.

Look in %TEMP%  directory for the majordomo.log file. This file contains information about the 

attempts to contact the workbench including information about any failures and the reason for the 

failures.

On the Windows operating system, the %TEMP%  directory is typically at %USERPROFILE%\AppData

\Local\Temp.

If the majordomo service is configured to log in as Local System Account, then the %TEMP%  directory 

is at %SystemRoot%\TEMP,  typically C:\Windows\TEMP.

• You can check the agent status on the workbench computer by clicking the  icon. For the Agent 

Controller, you can attempt to share files between the workbench computer and agent computers. 

Click Window  > Preferences  > Agent Controller  > Hosts, and then add the agent computers as 

hosts, and click Test Connection  to test connectivity to the instances of the Agent Controller that 

are running on the agent computers.

Recording configuration problems

No HTTP traffic is captured while recording

See Recording reliable HTTP tests  on page  for instructions on configuring your web 

browser. If you are attempting to use Internet Explorer to record tests from a secure website, 

see Configuring Internet Explorer for recording from a secure web site  on page . 

Disable firewalls on the workbench computer and the agent computers.

No traffic is captured while recording
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Ensure that the recorder type that you select matches the protocol in use by the system 

under test. For example, do not attempt to use the HTTP recorder if the system under test 

uses the Citrix protocol.

No test is generated after recording

When the test generator cannot create a test from the recorded traffic, typically an error 

message is displayed or written to the error log. Try looking up the error message in the 

Performance testing error messages  section of the online help. Error messages might 

also be documented in technotes in the Support Knowledge Base at http://www.ibm.com/

software/awdtools/tester/performance/support/.

Recorder controls are not available

If you use a workspace from a different version of the product, the recorder controls might 

not be available. Instead, the recorder controls from the other version of the product are 

displayed. Click Window  > Reset Perspective  to reset the Performance Test  or Service Test 

perspective. Alternately, click File  > New  > Other  to select the wizard to use.

Problems running large tests or long-run tests

If a test runs but ends with errors, check that the workbench computer and agent computers meet the 

hardware and software requirements that are detailed in the installation guide. Pay close attention 

to the memory and disk space requirements. See Increasing memory allocation  on page  for 

more information on how to set the maximum heap size to avoid out-of-memory errors. Monitor 

processor and memory usage on the workbench and agent computers and watch for excessive 

processor use or excessive memory use by javaw.exe or java.exe processes. If error messages pertain to 

processes stopping unexpectedly, see this support article: http://www.ibm.com/support/docview.wss?

uid=swg21395486.

Run tests with fewer virtual users that use the default schedule settings to determine whether the 

behavior is linked to the number of users. Examine the test log for error messages that the system 

under test generates. Run tests with a single virtual user and make sure that the system under test is 

not generating errors, before you attempt to run tests with a large number of users. If you encounter 

problems, restart the workbench and agent computers before attempting to run tests again.

If the workbench shuts down while running tests, search for file names that begin with javacore. The 

name of javacore  files includes the date, time, and process ID. If you find a javacore  file with a date, 

time, and process ID matching the workbench, open the file in a text editor. You can find the reason for 

failure at the beginning of the javacore  file.

http://www.ibm.com/software/awdtools/tester/performance/support/
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Data correlation errors

If you can record tests successfully, but the expected behavior is not triggered in your application 

when you run tests, you might need to perform manual data correlation. Typically when additional data 

correlation is needed, the test log includes messages similar to this message:Unable to extract the 

value. To troubleshoot data correlation problems, try running tests using only one virtual user running on 

the workbench computer, and compare the playback to the recorded test to determine which responses 

from the system under test are unexpected. See Debugging HTTP tests  on page  to learn how 

to use the test log and the Protocol Data  view to troubleshoot HTTP tests. To learn more about data 

correlation, see Correlating response and request data  on page .

Common errors integrating with IBM®  Rational®  Quality Manager

All modes of the adapter use the Eclipse error log. You can view the log by opening the workbench and 

clicking Window  > Show View  > Error Log. By default, warning and error messages are logged. You can 

turn on more detailed logging for the adapter by clicking Window  > Preferences  > Logging. The log 

component for the adapter is named com.ibm.rational.test.lt.rqm.adapter.

If you are running the adapter as a Windows™  service or from the command line, you can view the 

adapter.log  file without opening the test workbench.

Problem Solution or cause

Where do you look for errors or 

warnings?

In the workbench, click Window  > Show View  > Error Log.

You do not see the adapter 

available for selection.

• Verify that the Rational®  Quality Manager  server address 

that is provided to the adapter is correct. Provide the cor

rect address.

• Check the provided login and password. Provide the cor

rect password.

The adapter continuously fails 

to connect to Rational®  Quality 

Manager.

Make sure that the server is running. If necessary, restart the serv

er or check network connectivity.

The adapter is displayed as red 

in the selection dialog box.

• The adapter is not communicating with the server.

• The adapter might already be in use.

You attempt to import a script 

from the adapter but no scripts 

are found.

• Make sure the project path that is entered in Rational® 

Quality Manager  is a project under the workspace that is 

associated with the running adapter. You have to enter on
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Problem Solution or cause

ly the project name. This is less error prone than typing the 

complete project path, but either forms are acceptable.

• If running from the command line or as a service, be cer

tain the WORKSPACE_DIR  environment variable that is set 

in the adapter.config  file is the same path as seen in 

the select workspace dialog box when running the test 

workbench. Be careful not to set the path to a project fold

er under the workspace directory.

• Make sure that you are not using a workspace that con

tains a project that was copied from a shared location. A 

workspace that contains projects from shared locations 

cannot be used for projects that are not shared.

The adapter is running from the 

command line or as a service, 

and tests continue to fail.

Run the adapter in GUI mode so that you can see what happens 

when the test workbench runs the test script.

Adapter Windows™  services 

does not start. A error message 

states that the service failed to 

start in a timely fashion.

Ensure that the computer has .NET 2.0 or later. This platform 

can be installed from the Windows™  Update Site or manually. For 

more information on installing .NET, see http://support.microsoft

.com/kb/923100.

When testing shared assets, 

the execution fails with and an 

IOException  message is dis

played.

The most likely cause is that the Rational®  Quality Manager  to 

UNC shared location is not set up correctly.

• From Rational®  Quality Manager, ensure that you can ac

cess the UNC shared directory without being prompted for 

a password. You might have to map a drive on Windows™ 

for the Rational®  Quality Manager  system to log into the 

UNC share.

• Ensure that you have defined the shared resource in Ratio

nal®  Quality Manager  under Admin  > System Properties  > 

Resources.

• Ensure that the test-script points to a shared location that 

still exists. If you have associated a Rational®  Quality Man

ager  test script with a shared location that has changed 
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(for example if the IP address has been reassigned) you 

might need to reassociate every test script

• Ensure that the UNC shared directory that is specified in 

Rational®  Quality Manager  points to a project.

When testing shared assets, the 

execution fails with a low level 

model error.

Ensure that the adapter has the required protocol extensions in

stalled. The test assets located on the shared location can only be 

run on an adapter workspace that supports those protocols.

Service tests that were creat

ed in a previous version of the 

product cannot be run.

Upgrade every SOA asset to the latest version.

The adapter cannot connect to 

the server, and one of the fol

lowing error messages is dis

played:

• Communications error 

with server

• Error occurred while 

registering the 

adapter

• When using Rational®  Quality Manager  3.0 or later, the 

server URL that is configured for the adapter must exact

ly match the public URI of the Rational®  Quality Manager 

server. The server public URI is available on the Rational® 

Quality Manager  administration page. By default the ad

ministration page is at https://servername:9443/qm/ad

min.

• The adapter user must be a member of the Rational®  Qual

ity Manager  project area. Open the project area adminis

tration page on the Rational®  Quality Manager  server to 

determine whether the adapter user is a member of the 

project area. For Rational®  Quality Manager  3.0 and later, 

the adapter user must be a member in the test team mem

ber role, not the test team contributor role. This error can 

also occur if you have modified these roles from their de

faults.

Performance testing error messages
Find more information about the error messages.

PRXE0101W %1 terminating due to exception: %2
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PRXE4943W Transaction [%1] has been aborted.

PRXE4951I User group [%1] was not found.

RMSE0003W RMSE0003W There are currently no selected counters for the source named {0}.

Explanation: The source has no counters selected.

System Action: Execution of the schedule will continue but the information related to this source won't be 

collected.

User response: Consider selecting at least one counter from the Resource Monitoring Service web 

console.

RMSE0004W RMSE0004W The source named {0}  is no longer available.

Explanation: This source has been removed from the Service web console after it was added to this 

schedule.

System Action: Execution of the schedule will continue but the information related to this source won't be 

collected.

User response: Consider adding it back, then edit the schedule to update the sources to be monitored 

during its execution.

RMSE0005W RMSE0005W The source named {0}  is reporting the error message {1}.

Explanation: Look at the reported error.

System Action: Execution of the schedule will continue but the information related to this source won't be 

collected.
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User response: Consider fixing it from the Resource Monitoring Service web console.

RMSE0006W The server does not support resource monitoring labels.

Explanation: The server does not support resource monitoring labels.

System Action: Execution of the schedule will continue but the resource monitoring counters won't be 

collected.

User response: Consider using a service that supports this feature.

RPAC0001W The JAR %1 referenced in preferences could not be found. Preferences on the cloud 

workbench will be cleared.

Explanation: The Resource Monitoring preferences list a JAR file that is required for an instrumented 

application server type. This JAR file must be mapped to a new location and transferred to the cloud 

workbench. But this transaction failed, because the file could not be found locally.

System Action: Execution in the cloud will continue but the instrumented application server types that 

require the listed JAR file might fail.

User response: Open the child preference page under Test -> Performance Resource Monitoring. Ensure 

that the listed files exist and can be found in a valid location.

RPHD1032E Error occurred while instructing __PT_ACRONYM__ engine to enable real-time 

protocol data for user: %1. It's possible that no data will be seen for this user in the 

Protocol Data view.

Explanation: There was a general error when starting real-time browsing in the Protocol Data View.

System Action: The Protocol Data View will not be updated in real-time during this run. This does not 

affect test execution or post-run usage of the view.

User response: Ensure there is a stable connection with the Performance Test Agent and System Under 

Test. If problem persists, contact support.
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RPHD1034E Error occurred while instructing __PT_ACRONYM__ engine to disable real-time 

protocol data for user: %1. It's possible that data for this user will continue to be 

displayed in the Protocol Data view.

Explanation: = There was a general error when ending real-time browsing in the Protocol Data View.

System Action: None.

User response: If the Protocol Data View no longer updates for additional runs or when the test editor 

selection is changed, closing the view and reopening it may help.

RPHE0001E example of translatable error message %1

RPHE0010W Unknown authentication scheme '%1' discovered in HTTP 401 response, ignoring.

RPHE0011W Unrecognized authentication header '%1' discovered in HTTP 401 response, ignoring.

RPHE0012W No authentication headers found in HTTP 401 response, ignoring.

RPHE0013W The server requested NTLM authentication but no NTLM authentication context was 

supplied with this request. Authentication is not possible.

RPHE0014W NTLM authentication failed for this request. Verify that the NTLM authentication 

context values for this request are correct.
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RPHE0100W Host name '%1' can not be resolved.

Explanation: A connection could not be established with the host. This can occur if the testing 

environment changes so that the host name is no longer correct. This can also occur when running a test 

on a different computer, such as an agent computer, from the workbench computer that was used for 

recording, if the new computer cannot resolve the host name.

User response: If the host name is incorrect due to a change in the testing environment, update the host 

name in the test. Otherwise, try to resolve the host name using the command nslookup <hostname>. 

Run nslookup on the agent computer if the error is happening on the agent computer. If nslookup is also 

unable to resolve the name, contact your network administrator. If nslookup resolves the host name, but 

the test continues to fail, try changing the host name to a fully-qualified host name. Alternatively, edit the 

hosts file.

RPHE0101W Encountered error while updating dynamic cookie cache while interpreting 'Set-

Cookie' header with value '%1' sent from web-server '%2' retrieving URI '%3'. 

Explanation message: '%4'. Cache not updated to include this cookie value.

RPHE0102W Unexpected challenge(HTTP status code=401) received during HTTP playback to 

web-server '%1' retrieving URI '%2'. This behavior differs from the behavior recorded 

during test creation. For authentication to playback correctly a challenge must be 

recorded during test creation.

RPHE0103W Authentication failed during HTTP playback to web-server '%1' retrieving URI '%2'. 

Probable cause: username '%3' and/or password '%4' incorrect.

RPHE0104W Exception occurred during attempt to write request to web-server '%1' getting url '%2'. 

Explanation: %3
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RPHE0105W General un-handled exception occurred during socket I/O read from web-server '%1' 

retrieving URI '%2'. Explanation message: '%3'.

Explanation: This error occurs when the server abruptly closes the connection to the virtual user. Servers 

might close connections if the virtual user is detected as a security risk due to a invalid cookie, failed SSL 

negotiation, or an improperly formatted request.

User response: Compare the request that was sent at run time (in the test log) to the one that is in the 

test. To determine if differences between the requests are valid, record the test again and compare the 

two requests.

RPHE0106W A read time-out occurred during a socket I/O read from web-server '%1' retrieving URI 

'%2'. Since this URI is the primary request for the current page all secondary requests 

will be skipped and the next page will be attempted. Current time-out value of '%3' 

milliseconds should be increased if long delays are expected on this page.

Explanation: The server did not return the response data before the timeout interval elapsed. If the server 

is under heavy load, the behavior can be caused by bottlenecks on the server or the agent computers. 

This error can also occur if an incorrect request is sent and the server is unable to respond.

User response: If the server is under heavy load, examine the server and agent computers to find and fix 

bottlenecks. Increase the timeout value. To stop tests or virtual users when this error occurs, enable error 

handling in the test and configure the server timeout error condition. If the server is not under heavy load, 

examine the request to ensure that it is valid and accurate.

RPHE0107W A read time-out occurred during a socket I/O read from web-server '%1' retrieving 

URI '%2'. This secondary request will be skipped. Current time-out value of '%3' 

milliseconds should be increased if long delays are expected on this request.

Explanation: The server did not return the response data before the timeout interval elapsed. If the server 

is under heavy load, the behavior can be caused by bottlenecks on the server or the agent computers. 

This error can also occur if an incorrect request is sent and the server is unable to respond.
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User response: If the server is under heavy load, examine the server and agent computers to find and fix 

bottlenecks. Increase the timeout value. To stop tests or virtual users when this error occurs, enable error 

handling in the test and configure the server timeout error condition. If the server is not under heavy load, 

examine the request to ensure that it is valid and accurate.

RPHE0108W A connect time-out occurred during a socket I/O connect to web-server '%1' 

attempting to retrieve URI '%2'. Since this URI is the primary request for the current 

page all secondary requests will be skipped and the next page will be attempted.

Explanation: This error can occur if the server or agent computer is under heavy load. This error can also 

occur if the server or host computer is not configured with enough connections, or if the agent computer 

is not configured with enough sockets.

User response: Examine the server and agent computers to find and fix bottlenecks. To stop tests or 

virtual users when this error occurs, enable and configure error handling in the test.

RPHE0109W A connect time-out occurred during a socket I/O connect to web-server '%1' 

attempting to retrieve URI '%2'. This secondary request will be skipped.

Explanation: This error can occur if the server or agent computer is under heavy load. This error can also 

occur if the server or host computer is not configured with enough connections, or if the agent computer 

is not configured with enough sockets.

User response: Examine the server and agent computers to find and fix bottlenecks. To stop tests or 

virtual users when this error occurs, enable and configure error handling in the test.

RPHE0110W Unexpected challenge(HTTP status code=407) received while accessing HTTP proxy 

'%1' retrieving URI '%2'. This behavior differs from the behavior recorded during test 

creation. For authentication to playback correctly a challenge must be recorded 

during test creation.

Explanation: When the test was recorded, no basic authentication was required on the proxy server. When 

the test is run, the proxy server is requesting basic authentication information that is not in the test.
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User response: Record the test again to capture basic authentication information. Play back the new test, 

or add the basic authentication information to the request in the original test.

RPHE0111W Authentication failed accessing proxy-server '%1' retrieving URI '%2'. Probable cause: 

username '%3' and/or password '%4' incorrect.

Explanation: Basic authentication failed when connecting to the proxy server. This can occur if an 

incorrect user name or password is supplied.

User response: Ensure that user name and password are correct.

RPHE0112W An error occurred during decoding of content received from web-server '%1' 

attempting to retrieve URI '%2'. Explanation message: '%3'.

RPHE0113E Error encountered during the process of URI substitution for host=%1 and URI 

=%2 . Data correlation supplied a malformed URI=%3 . Explanation: %4. If you 

attempted to perform a custom data substitution on this URI ensure it has proper 

URI syntax. If you did not perform a custom data substitution then an internal may 

have been encountered and you should contact product support for further problem 

determination.

RPHE0113W An error occurred during encoding of an annotated execution history event property. 

Explanation message: '%1'.

RPHE0114E An error was encountered during transform of response data. %1

Explanation: The response data was not in a format that the data transformer could interpret. This can 

occur when an error is returned from the server instead of valid response data.

User response: Examine the response data for errors.
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RPHE0114W Exception occurred during attempt to write request to proxy-server '%1' getting URL 

'%2' on host '%3'. Explanation: %4.

RPHE0115E An error was encountered during un-transformation of request data. %1

Explanation: The transformed request data could not be converted into the format required by the server. 

This can occur because of a faulty data substitution. This can also occur if you manually edit the request 

data and invalidate the transformed data format.

User response: Correct the faulty substitution or the invalid data formatting.

RPHE0115W Unable to successfully establish a connection to web-server '%1' retrieving URI '%2'. 

Web-server closing the connection after connection was just established.

RPHE0117W Unexpected exception occurred during connection close to web-server '%1' retrieving 

URI '%2'. Explanation: %3.

RPHE0118W HTTP parsing error encountered while retrieving URI '%1' from web-server '%2'. If this 

URI is the primary request for the current page all secondary requests will be skipped 

and the next page will be attempted.

RPHE0119E IP aliasing is enabled but no IP address was found for virtual user %1. Verify correct 

network interface name(s) are specified.

RPHE0120E Exception occurred during attempt to connect to proxy-server '%1' getting URL '%2' on 

host '%3'. Explanation: %4.
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RPHE0121E Unable to authenticate with the proxy-server. Possible solution: re-record test due to 

possible proxy-server '%1' authentication changes.

RPHE0122W Web-server '%1' unexpectedly closed the connection while in the process of retrieving 

URI '%2'. The response body MAY be incomplete due to a missing "chunk". If missing 

chunk was last (zero length) chunk, data is complete.

RPHE0123W Infinite redirection loop detected getting URL '%1'. If this is expected and understood 

increase RPT_VMARGS rptMaxRedirection parameter. Redirected history %2

RPHE0124W Unexpected server redirection occurred getting URL '%1'. We were redirected to the 

same URI which issued this request. Redirected history %2

RPIB0007E %1

RPKG0090E Exception thrown while creating connection variables

Explanation: Exception thrown while creating connection variables

System Action: Can not create the connection variable

User response: None required

RPKG0100E Exception thrown by the launch configuration core

Explanation: Exception thrown by the launch configuration
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System Action: None required

User response: None required

RPKG0101E Exception thrown during an update to a launch configuration

Explanation: Exception thrown during an update to a launch configuration

System Action: None required

User response: None required

RPKG0110E The data source type %1 is not expected

Explanation: The data source type %1 is not expected

System Action: None required

User response: None required

RPSE0014W SAP Calendar dialog could have unpredictable behavior during playback, set the date 

directly in the field using string format.

Explanation: SAP Scripting Calendar object is not safe, in hide mode replay could fail.

System Action: No specific action during test generation. Recorded actions are kept.

User response: Date should be set in corresponding field as String value, ex: 10.25.2021

RPSF0114E SAP GUI Application creation failed

Explanation: SAP GUI is not installed with recommended scripting options.

System Action: Recording is stopped.
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User response: Install SAP GUI with scripting options as recommended by SAP.

RPSF0172E __PT_ACRONYM__/SAP: Unable to start SAP GUI, please check SAP GUI installation.

Explanation: SAP GUI can't be reached.

System Action: The test is stopped.

User response: Install SAP GUI with scripting options as recommended by SAP.

RPSF0195E Connection with SAP GUI existing session or shortcut not allowed during schedule 

execution.

Explanation: Connection on existing SAP GUI session or shortcut are impossible in a performance 

schedule execution, these are reserved for test or coumpound test.

System Action: The test is stopped.

User response: Connection string or SAP logon must be used for schedule mode.

RPTA0000W %1

RPTA0001I Setting the log verbosity left me with %1 users

RPTA0002E A Test cannot be launched on the specified Driver

RPTA0003E %1
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RPTA0004E A Test could not be launched on Driver: %1. The Test Execution Framework was not 

able to deliver an Executor. This is an internal error, please contact support. For more 

information, see the Troubleshooting section of the online help.

Explanation: The Test and Performance Tools Platform (TPTP) infrastructure did not produce an executor 

for the test. This error message might display if firewalls are active on the local computer or the agent 

computer.

User response: Disable firewalls on both the local computer and the agent computer. If you do not want to 

disable firewalls, you can instead enable a firewall-aware connection. For more information on enabling a 

firewall-aware connection, see Running with a workbench behind a firewall. On the local computer, check 

the properties of the location that represents the agent computer. This error can occur if the deployment 

root directory is not specified correctly in the location that represents the agent computer. Check the Error 

Log for further information on the error. To open the Error Log, click Window > Show View > Error Log. 

Restart the Agent Controller. Restart the application.

RPTA0009E A Test could not be launched on Driver: %1 due to an internal error. Please see 

Problem Determination Log. For more information, see the Troubleshooting section 

of the online help.

Explanation: An exception was thrown during an attempt to obtain the operating system attribute of the 

location asset.

User response: Check the Error Log for further information on the error. To open the Error Log, click 

Window > Show View > Error Log. Open the location asset representing the agent computer in the Test 

Navigator, and verify that all information and properties are correct. Delete the location asset representing 

the agent computer in the Test Navigator, and create a new location asset. You might need to delete the 

location and create a new one, if the location asset representing the agent computer asset is corrupted.

RPTA0010E An error has been encountered while launching a Test on Driver: %1. Please see 

Problem Determination Log. For more information, see the Troubleshooting section 

of the online help.
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Explanation: An exception was thrown while starting the test. The exception did not contain an error 

message.

User response: Check the Error Log for further information on the error. To open the Error Log, click 

Window > Show View > Error Log. Restart the Agent Controller. Restart the application.

RPTA0011E An error has been encountered while launching a Test on Driver: %1. An Executor 

was not returned and neither was an error message. This is an internal error, please 

contact support.

Explanation: The Test and Performance Tools Platform (TPTP) infrastructure produced neither an 

executor for this test nor error messages.

User response: Check the Error Log for further information on the error. To open the Error Log, click 

Window > Show View > Error Log. Restart the Agent Controller. Restart the application.

RPTA0012E An error has been encountered while launching a Test on Driver: %1. There are no 

Data Processors present. This is an internal error, please contact support.

RPTA0013E An error has been encountered while launching a Test on Driver: %1. Data Processors 

have not been configured correctly. This is an internal error, please contact support. 

For more information, see the Troubleshooting section of the online help.

Explanation: The test application was unable to configure the Data Processor for either the test log or the 

statistics portion of the test infrastructure.

User response: Check the Error Log for further information on the error. To open the Error Log, click 

Window > Show View > Error Log. Restart the Agent Controller. Restart the application.

RPTA0014E A Test could not be launched on Driver: %1. The Test Execution Framework 

encountered an Exception. This is an internal error, please contact support.



Chapter 1. Troubleshooting Guide

RPTA0015E An error was encountered while launching a Test on %1.\nPlease examine your 

Deploy Directory: %2, the error could be caused by one of the following:\n\n1. 

The Deploy Directory path must be absolute (start with Drive Letter or "/").\n2. 

The Deploy Directory path must be valid for the Target Operating System.\n3. The 

__VENDOR_NAME__ Agent Controller must have authority to this directory.\n4. An 

error was encountered while deploying to this directory.

RPTA0016E An error has been encountered while launching the test. A required dataset %1 is 

missing or invalid in your project.

RPTA0017E An error has been encountered while launching the test. A required dataset %1 has 

been replaced. One or more test(s) are referencing a different version of the dataset.

RPTA0018E ready

RPTA0019E not ready on port

RPTA0020E Check Agents Failed

RPTA0021E %1 deployment directory %2 format not compatible for operating system %3. For 

more information, see the Troubleshooting section of the online help.

Explanation: The deployment directory that is specified in the location asset representing the agent 

computer is incorrect for the operating system that is specified in the location asset.
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User response: Open the location representing the agent computer in the Test Navigator, and edit the 

deployment directory or the operating system.

RPTA0022E Timed out after %1 seconds waiting for the license server. Check network 

connectivity to the license server and ensure the license server is running. For more 

information, see the Troubleshooting section of the online help.

Explanation: The test application was unable to connect to the license server in the allotted time.

System Action: The test run stops.

User response: Run the __RLKA_NAME__ to check for connectivity to the license server or to point to a 

different server.

RPTA0023E Virtual users have exited prior to stage completion. At the end of stage %1 there were 

%2 users running when %3 were expected. A common reason for this is a schedule 

which has assigned an insufficient amount of work (for one or more User Groups), to 

keep the associated virtual users active for the full amount of time specified by the 

stage duration(s). Review the schedule for sufficient workload. When using multiple 

stages it is strongly recommended to use infinite loops to ensure that virtual users 

always have enough work scheduled regardless of the total duration of all the stages. 

Another possible reason is that one or more virtual users exited upon encountering a 

serious error; consult the Test Log or Common Base Event XML log on the agent for 

more information. Also see the Troubleshooting section of the online help.

Explanation: During schedule execution, at the end of the current stage, the actual number of users 

running did not match the expected number of users. For example, if the current stage specifies that 

100 users should run for 1 hour and only 90 users are running at the end of the hour, this message is 

displayed.

User response: Check the Error Log for further information on the error. To open the Error Log, click 

Window > Show View > Error Log. Typically, this message is displayed when virtual users did not have 

enough work to do for the duration of the stage. For schedules that contain more than one stage, verify 

that the workload under each user group is contained inside an infinite loop. Use infinite loops because 

the stage duration is controlled by the time when users stop. If virtual users have sufficient workload, 
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look in the test log for more information about why virtual users stopped. The virtual users that stopped 

might have encountered errors. By default, this message is displayed when the number of expected users 

does not match the number of actual users running at the end of a stage. You can change this setting 

to specify the percentage of users that may stop during a stage without being considered an error. To 

change the error condition, create the -DrptStopTolerance property in the eclipse.ini file in the installation 

directory. For example, -DrptStopTolerance=80 specifies that 80% of the users may stop unexpectedly 

during stage execution without being considered an error.

RPTA0024E Exception encountered adding or removing users.

Explanation: This error message is displayed when a dataset reference between a test and a dataset is 

broken. Whenever a dataset is used, a reference is created in the test. The reference is a link that points 

to the physical dataset file in the test project. This link can break if the test is copied or imported into 

another project without copying or importing the associated dataset file. This link can also break if the 

dataset file is deleted.

System Action: None.

User response: Do not copy or import individual test assets. Instead, copy or import entire projects. If 

you have already copied or imported individual test assets, copy the dataset from the previous project or 

create a new dataset that contains the same information. Open the test with the broken reference and link 

the dataset to the test. \nDo not delete dataset files.

RPTA0025E The schedule has no user group.

RPTA0026E The RPT_VMARGS option rptPre811PageResponseTimes is specified on at least one 

location and is missing from at least one other location. Please ensure that either 

all locations include this option or none do. See "adjusted page response time for 

increased accuracy" in the help for more information.

RPTA0025I Run Completed (%1)
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RPTA0026I Run Terminated (%1)

RPTA0027I %1: %2

RPTA0031E Location template file %1 is not found (referenced from location file %2)

Explanation: A location template file referenced by a location file is missing or inaccessible.

User response: Create a location template file with the given name. If the location template file exists but 

is in a closed project, open the project.

RPTA0032I Found location template [%1] for [%2] (instances found: %3)

RPTA0033I %1 remote location(s) associated with location template [%2]

RPTA0034E Cannot change stage duration if Until Finished specified

RPTA0035E Duration time specified is less than what has already elapsed

RPTA0036E Schedule must be in the Running state to change stage duration

RPTA0037E Agent %1 not ready, time of last contact: %2
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Explanation: The specified agent is not in contact with the workbench. The schedule cannot run until all 

agents that are used in the schedule are actively connected.

System Action: Install and configure the Rational®  Performance Tester  load generation agent on the 

agent computer.

User response: Ensure that the specified agent has a Rational®  Performance Tester  load generation 

agent installed and is properly configured to this workbench. Restart the schedule. See the online help for 

information about how to install and configure the load generation agent.

RPTA0038E No successful contact

RPTA0039E Unknown host '%1'

Explanation: The specified agent name is not resolving in the Domain Name System (DNS).

User response: Ensure that the agent name is spelled correctly in the location.

RPTA0040E Unable to complete deployment to agents because of an unexpected error in the 

publish phase. %1

Explanation: A deployment error occurred that is likely a low-level I/O error or an unrecoverable internal 

error.

User response: Check the exception messages for possible causes such as a lack of hard-disk space.

RPTA0041E %1

Explanation: The specified agent is not in contact with the workbench. The schedule cannot run until all 

agents that are used in the schedule are actively connected.

System Action: Install and configure the __PT_RR_SHORTNAME__ load generation agent on the agent 

computer.
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User response: Ensure that the specified agent has a __PT_RR_SHORTNAME__ load generation agent 

installed and is properly configured to this workbench. Restart the schedule. See the online help for 

information about how to install and configure the load generation agent.

RPTA0042E Agent version %1 incompatible on host %2. Minimum agent version %3 required.

Explanation: The version of the __PT_AGENT_ACRONYM__ is not compatible with a feature in the 

schedule.

System Action: The schedule cannot be launched so schedule execution ends.

User response: Upgrade the __PT_AGENT_ACRONYM__ on the machine specified to match the 

workbench version.

RPTA0043E Error encountered

Explanation: An unexpected error occurred.

User response: Look for more details about the error in the message posted.

RPTA0100W Failed to delete file %1

RPTA0518E An error has been encountered while launching the test. A required dataset %1 is 

missing or invalid in your project.

Explanation: A test contains a link to a dataset that cannot be found or that is corrupted. This can happen 

when a project is not imported completely, or when a file is deleted.

System Action: The test run does not start.

User response: Open the test. On the Common Options page, fix the broken link so that it points to a valid 

dataset file or delete the link.
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RPTA1050E Rational®  Service Tester  is licensed to only support single user execution. 

Please adjust the number of Users to 1 in the schedule and rerun. Contact 

__VENDOR_NAME__ regarding the use of __PT_RR_SHORTNAME__ for your load 

testing needs..

RPTC0003E Wrong type of project '%1'.

RPTC0004E Unable to access test variable initialization file. Make sure the specified file path is 

accessible: %1

RPTC0005E Error while processing XML file containing variable initializations. Make sure the file 

contains valid XML of the expected format: %1

RPTC0006E Error while gather test variable initializations. No variable initializations will be 

honored for this run.

RPTC0007E Error processing license request for feature '%1'. This feature will not be available.

Explanation: The workbench could not find the ibmrpt_pvu license. Either the license does not exist with 

the license server or activation kit or the workbench was unable to acquire it. As a result, the capabilities 

that this license enables are not be available.

User response: To enable the capabilities for the license, ensure that the ibmrpt_pvu license is available 

for the workbench.

RPTC0008I Setting Variable [name='%1', value='%2', source='%3', user group='%4', location='%5']
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RPTC00020E Unexpected I/O error while communicating with workbench %1

Explanation: During test-log transfer a network error occurred on the agent communicating to the 

workbench.

System Action: The agent re-attempts to communicate with the workbench.

User response: If the problem persists, inspect error and take corrective action.

RPTC1001W The file path specified for the Zip Utility is invalid.

RPTC1002W Could not get the classpath for project '%1'.

RPTC1009I Undefined

RPTC1011I %1: Request delivered

RPTC1012I %1: successfully added %2 to the configuration file

RPTC1013I %1: successfully removed %2 from the configuration file

RPTC1014I %1: %2 is already in the configuration file
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RPTC1015I %1: Request timed out

RPTC1016I %1: Agent not ready

RPTC1017I %1: Agent not known

RPTC1018I %1: Unknown host exception

RPTC1019I %1: %2

RPTC1020I License type: %1

Explanation: Lists the brand of licensing being used (either HCL or IBM).

System Action: License checkouts will attempt to acquire a license of the corresponding type.

User response: No action required.

RPTC1021I License valid: %1

Explanation: Indicates whether a valid license was successfully acquired (true/false).

System Action: If true, the functionality associated with the acquired license will be enabled.

User response: If false, check your license configuration.
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RPTC1030E Unable to replace dataset '%1' with '%2': %3.

Explanation: An error occurred attempting to replace datasets.

System Action: Execution will complete with error.

User response: Refer to the error message for more details, change the command line options related to 

replacing datasets.

RPTC1031E The dataset '%1' doesn't exist.

Explanation: Unable to locate the specified dataset referenced in the dataset command line option.

System Action: Command line execution will be cancelled.

User response: Change the command line options related to replacing datasets.

RPTC1032E The dataset '%1' is incompatible with existing dataset '%2'.

Explanation: The specified replacement dataset does not have compatible columns, type, etc.

System Action: Execution will complete with error.

User response: Ensure the dataset has the same columns of the dataset it is replacing.

RPTE0005W Unable to attach requirements report into RQM result, because the default 

requirements report has been deleted. You can recreate the default reports by click 

restore defaults button on the Default Reports preference page.

Explanation: When a test run started by __QM_NAME__ completes, the default report is attached to the 

__QM_NAME__ execution results. This error occurs when the report selected as the default report on the 

Default Report preferences page does not exist.
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System Action: No report is attached to the __QM_NAME__ execution results.

User response: Click Window > Preferences > Test > Performance Test Reports > Default Report to open 

the Default Report preferences page. Check that the selected report exists. Click Restore Defaults to reset 

the default reports.

RPTE0011W Unexpected error while releasing system resources for test log export. This may 

cause an increased memory footprint, until Rational®  Performance Tester  is 

restarted.

Explanation: Test log export has completed (possibly with errors described earlier in the workspace log), 

but when releasing assets used during the export operation, there was an unexpected error.

System Action: Memory allocated to this operation may not have been freed. Previous errors are likely to 

be present explaining the root cause.

User response: It is advisable to restart the application to free memory allocated during this operation. 

The exported test log file may be available but there may be errors.

RPTE0147E The password saved for an encrypted column in dataset "%1" was invalid. Set a new 

password in the Automation Security preference page.

Explanation: The value saved in the Automation Security preference page for the specified dataset was 

not correct. It will be ignored.

System Action: The password in the preference is ignored. If running from the workbench, it will prompt 

for a password before execution. Otherwise, execution will fail.

User response: Update the password in the Test - Test Execution - Automation Security preference page.

RPTE0150E The feature %1 used in test %2 is not supported in the current installation/platform.

Explanation: The execution failed because the specified feature is not supported in the current installation 

of the product.
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System Action: Ensure feature is selected during installed. Ensure feature is supported on the given 

architecture/operating system.

User response: No user action is required.

RPTH0130I No sample time closely matches request at time=%1

RPTH049E A statistical adapter is missing reference to the target result.

Explanation: This is an internal error when loading results files. It could indicate that the result is 

corrupted, or it could only be a timing issue.

System Action: The result cannot be opened.

User response: Close all reports and restart the workbench. If the result still does not open, kill any CPU-

intensive processes running in the background.

RPTI0069E Local on premise agent %1 not in contact with this workbench.

RPTI0070E See Error Log for more details.

RPTI0071I There was an error while updating the workspace after downloading remote files.

RPTI0072E Modify majordomo.config on %1 and configure it to poll this workbench.

RPTI0072I Remote Launch Status: %1



Chapter 1. Troubleshooting Guide

RPTI0073E Project is NULL

RPTI0074E Exception occurred while creating and unzipping project: %1

RPTI0075E Error running schedule. Could not find schedule %1 in project %2.

RPTI0110I Provision time (MM:SS): %1

RPTI0111I Launch time (MM:SS): %1

RPTI0112I Execution time (MM:SS): %1

RPTI0113I Results transfer time (MM:SS): %1

RPTI0141E ------------------------------------\nError Dialog\n%1: %2\nConsult workspace error log 

({workspace}/.metadata/.log) for further information.\n------------------------------------\n

Explanation: This message is displayed to the command-line output when an error occurs during 

execution. It displays details about the error and directs the user where to find additional information.

System Action: None.

User response: This message occurs as a generic way to display errors during command-line execution. 

Consult the workspace log for further details including additional error messages.
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RPTI0142E The Usage Metrics version %1 required by the licensed component %2 is not 

available.

Explanation: The license that you are using requires Usage Metrics reporting for a later version of the 

product.

System Action: The execution will not start.

User response: Update the product to a newer version, or obtain a license that is applicable to the current 

version of the product.

RPTI0143E The licensing system failed to return Usage Metrics enablement for component %1.

Explanation: An error occurred while determining if the license requires Usage Metrics reporting.

System Action: The execution will not start.

User response: Verify that the license is not meant for a newer version of the product. Otherwise, contact 

support.

RPTI0144W No RTCP instance is available to report Usage Metrics. No Usage Metrics will be 

reported for this execution.

Explanation: The license enables Usage Metrics reporting, but either the preference for the Usage Metrics 

server is not set, or it is set but the server is not active or reachable.

System Action: The execution will be done normally, but the Usage Metrics will not be logged. This is 

allowed by the license you are using.

User response: If you have set up __QUALITY_SERVER__, go to Preferences > Test > 

__QUALITY_SERVER__, and fill in the server details for Usage Metrics reporting. Verify that the server can 

be reached from this machine by going to http://servername:7828 in a browser on the local machine.
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RPTI0145E No RTCP instance is available to report Usage Metrics. Per license policy, execution 

cannot happen unless a RTCP is defined and running.

Explanation: The license requires Usage Metrics reporting, but either the preference for the Usage Metrics 

server is not set, or it is set but the server is not active or reachable.

System Action: The execution will not start.

User response: Install __QUALITY_SERVER__ (if not done already), then go to Preferences > Test > 

__QUALITY_SERVER__, and fill in the server details for Usage Metrics reporting. Verify that the server can 

be reached from this machine by going to http://servername:7828 in a browser on the local machine.

RPTI0146E TPTP Datapools and Datasets cannot coexist in the same test. Test run aborted.

Explanation: A legacy datapool and a new dataset were both detected in the same test.

System Action: Test execution will be aborted and will not be successful until the test contains only one 

of the two asset types (dataset or datapool).

User response: With the latest version of this product, convert the datapool to a dataset, then open the 

test containing the legacy datapool in the test editor and save it. Then, restart test execution.

RPTJ0063E An IOException was encountered while creating the Annotation File on Driver: %1

RPTJ0075E An IOException was encountered while creating the Execution Log File on Driver: %1 :: 

%2

RPTJ1002E Driver %1 returned an unrecognized response: %2. The last command sent was: %3
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RPTJ1003E While waiting for an acknowledgement from the Driver, an unrecognized response 

was received.

RPTJ1004E The workbench was waiting for an Acknowledgement from the __VENDOR_NAME__ 

Agent Controller on Driver %1 and none was received.

Explanation: A required response from an agent was not received.

System Action: Execution ends because the required acknowledgement from the agent was not received.

User response: Monitor resource usage on the agent. Add additional agents if memory or CPU usage is 

high on a any agent.

RPTJ1005E Error while processing a message from the __VENDOR_NAME__ Agent Controller.

Explanation: An unexpected error occurred while handling a command from a load generating agent.

System Action: Execution ends because of an unexpected error while communicating with an agent.

User response: Check the workbench Error Log for more information.

RPTJ1006E Execution failure. No status received from location %1 in %2 seconds. Workbench 

memory usage at %3 percent of the configured JVM heap. Possible location or 

workbench overload. For more information, see the Troubleshooting section of the 

online help.

Explanation: The workbench cannot communicate with the agent computer.

User response: Try running the schedule again, using default values for all parameters and running at 

reduced user load levels. It is possible one agent computer is overloaded. If you can run successfully with 

the default values, make changes to the schedule settings or user load incrementally to determine the 

cause of failure. Increase the statistics interval to 60 seconds and try running the schedule again. Check 
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the error log for messages that might indicate the cause of the failure. Click Window > Show View > Error 

Log to open the error log.

RPTJ1007E The Driver: %1 has encountered a communication error. Please refer to Problem 

Determination Log for more details. For more information, see the Troubleshooting 

section of the online help.

Explanation: The agent computer that the message specifies encountered a problem when trying to run a 

command sent from the workbench.

User response: Check the error log for messages from the agent computer that the error message 

specifies. Click Window > Show View > Error Log. Check the test log for any failures from virtual users. 

This message might be displayed when you add or remove users manually or by means of schedule 

stages.

RPTJ1008E The Driver: %1 has become unresponsive, possibly due to an out-of-memory 

condition. At last notification this Driver was using %2 percent of its allocated 

memory. Please refer to the "Increasing memory allocation" Help topic for 

information on how to increase memory allocation. For more information, see the 

Troubleshooting section of the online help.

Explanation: The workbench cannot communicate with the agent computer. The agent computer might 

have a memory allocation problem.

User response: Try running the schedule again, using the default values for Test Log and Problem 

Determination log levels. Follow the instructions in Increasing memory allocation. Set the memory 

allocation to the size of physical memory minus 256 megabytes, up to a limit of 1500 megabytes. For 

example, on an agent computer with one gigabyte of physical memory, set the memory allocation to 756 

megabytes.

RPTJ1009E The Driver: %1 is running %2, however the user selected %3 as the Drivers operating 

system.
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RPTJ1010E Error while transferring file on Driver: %1. Transfer FROM: %3 TO: %2

RPTJ1011E The '%1' Protocol/Feature is not supported on the %2 platform, so the Test %3 can't 

be executed on location %4. For more information, see the Troubleshooting section 

of the online help.

Explanation: The test includes a feature or protocol that is not supported on one of the agent computers 

where it is scheduled to run.

User response: Edit the schedule and associate the user groups that include the problem test with agent 

computers that support the feature or protocol.

RPTJ1012E The operating system (%1) for location %2 is not recognized. Please use an operating 

system that matches or begins with the name of one of the recognized platforms: %3

RPTJ1013E No valid license key for %1 Protocol/Feature found. The Test %3 cannot be executed. 

For more information, see the Troubleshooting section of the online help.

Explanation: The test includes a feature or protocol that requires a license for the number of virtual users 

that are included in the run.

System Action: The test run stops.

User response: Run the __BRAND_NAME__ License Key Administrator and check for available license 

keys for the feature or protocol and number of users that you want. To learn more about license keys, see 

the installation guide.\nAdd the required license key or point to a server that has the required license key.
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RPTJ1014E Execution on the %1 Platform requires a license and no valid license key (%2) 

was found to enable it, so the Test %3 can't be executed on location %4. For more 

information, see the Troubleshooting section of the online help.

Explanation: One of the agent computers that is specified for the test run requires a license, but no 

license key was available for that platform.

User response: Run the Rational License Key Administrator and check for available license keys for the 

platform that you want. To learn more about license keys, see the installation guide. Add the required 

license key or point to a server that has the required license key or run the test on a different platform.

RPTJ1015E The specified operating system (%1) for location %2 is inconsistent with the actual 

platform (%3) running at that location. Please update the operating system to match 

and then try again. For more information, see the Troubleshooting section of the 

online help.

Explanation: The operating system that is specified in the agent computer asset does not match the 

operating system that is running on the computer at the specified address.

User response: 1. Open the schedule in the test editor. 2. Select the user group that runs on the location 

mentioned in the error message. 3. In the Schedule Element Details, click the Locations tab, and then 

select the location mentioned in the error message. 4. Click Edit. 5. Select the appropriate value from the 

Operating system list. 6. Click OK.

RPTJ1016E After deploying File: %2 to Driver: %1, %3 Byte(s) where found on the socket. Please 

refer to the Problem Determination Log for more details.

RPTJ1017E An IOException ocurred while deploying File: %2 to Driver: %1. Please refer to the 

Problem Determination Log for more details.
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RPTJ1018E A SocketException ocurred while deploying File: %2 to Driver: %1. Please refer to the 

Problem Determination Log for more details.

RPTJ1019E An UnsupportedEncodingException ocurred while deploying File: %2 to Driver: %1 

Please refer to the Problem Determination Log for more details.

RPTJ1020E An IOException ocurred while deploying File: %2 to Driver: %1.\nA possible cause is 

that the __VENDOR_NAME__ Agent Controller was started by a non-root user. \nThe 

Agent Controller needs to be started by the root user.

Explanation: Deployment of test assets to an agent failed.

System Action: Execution ends because required test assets could not be copied to an agent.

User response: Ensure that the Majordomo process is started by the root user.

RPTJ1021E An InactiveAgentException has occurred while deploying to Driver: %1. Please refer 

to the Problem Determination Log for more details. For more information, see the 

Troubleshooting section of the online help.

Explanation: The Test and Performance Tools Platform (TPTP) infrastructure threw an 

InactiveAgentException when the TPTP infrastructure attempted to communicate with the Agent 

Controller.

User response: Check the Error Log for further information on the error. To open the Error Log, click 

Window > Show View > Error Log. Restart the Agent Controller on the agent computer.

RPTJ0121I Send RATEGENERATORS to: %1, string '%2'
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RPTJ1022E The workbench received notification that the execution process on Driver %1 has 

terminated.

Explanation: The process running on the agent computer ended unexpectedly.

User response: Ensure that there is at least one successful test run, possibly with fewer virtual users, 

so that the maximum memory value for the agent is set correctly. Check the javacore* file on the agent 

computer or the logs in the deployment directory for further information on the process failure.

RPTJ1023E Communication with Driver %1 has been lost, possibly due to an out-of-memory 

condition. At last notification this Driver was using %2 percent of its allocated 

memory. Please refer to the "Increasing memory allocation" Help topic for 

information on how to increase memory allocation. For more information, see the 

Troubleshooting section of the online help.

RPTJ1024E Error during initialization of annotation transfer progress listener.

RPTJ1025I Run Completed (%1)

RPTJ1026I Run Terminated (%1)

RPTJ1030E Non-fatal internal exception occurred during code generation optimization. Code 

generation will not use meta-cache.
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RPTJ1040E The license required for the '%1' Protocol/Feature and %2 virtual users could not 

be checked out, so the Test %3 cannot be executed. For more information, see the 

Troubleshooting section of the online help.

Explanation: The test application was unable to check out a license for a feature or protocol in the test 

run.

User response: Run the Rational License Key Administrator and check for available license keys for the 

platform to run the feature or protocol. Add the required license key, point to a server that has the required 

license key, or run the test on a different platform.

RPTJ1041E The '%1' Protocol/Feature is disabled due to a licensing configuration error.

RPTJ1042E %1 Failure checking out license for '%2' Protocol/Feature and %3 virtual users. The 

Test %4 cannot be executed.

RPTJ1043E %1 The '%2' Protocol/Feature is not supported on the %3 platform, so the Test %4 

can't be executed on location %5.

RPTJ1044E Timed out after %1 seconds while waiting for the license server. Ensure that network 

connectivity to the license server exists and that the license server is running. For 

more information, see the Troubleshooting section of the online help.

RPTJ1100I A hang has been avoided during execution history receipt with %1 by a forceful load 

test executor state change



Chapter 1. Troubleshooting Guide

RPTJ1101E A session on driver %1 did not release promptly. Please check the agent controller.

RPTJ1102W The testLog event loader thread in the workbench has ended before processing all 

testLog events from %1. The testLog may be incomplete.

RPTJ1103W The test executor for %1 has been artificially set to HISTORY_COMPLETE because 

the testLog event loader thread is not longer running.

Explanation: A monitoring process indicates that the test log loader stopped prematurely. This is not a 

definite indication of a problem.

User response: Check that the expected events exist at the end of the test log. If so, no further action is 

necessary.

RPTJ1104E Remote debug never received event %1, process exit value %2

Explanation: Expected remote debug event was not received

User response: Check the Error Log for remote process failure reason

RPTJ1141E Temporary dataset file %1 not created.

Explanation: Temporary dataset file can't be created on the system.

System Action: Original dataset is used.

User response: Check corresponding file properties on the system.
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RPTJ1142E Temporary dataset data are not generated: %1

Explanation: Error reached during data generation.

System Action: Original dataset is used.

User response: Check corresponding connection information.

RPTJ1200W Failed to delete file %1

RPTJ1220E An InactiveAgentException has occurred attempting to send [%1] to driver %2

RPTJ1221E The CommandHandler for %1 has encountered an exception while processing %2

RPTJ1240E Driver %1 has reported a NOK. The last command sent to that driver was: %2

Explanation: A schedule command sent from the workbench to the agent computer could not be run by 

the agent computer.

User response: Run the schedule using the default settings. Look for unusual assignments of numbers of 

virtual users to agent computers at stage transitions.

RPTJ1241E Driver %1 has reported a NOK with the message: %2. The last command sent to that 

driver was: %3

RPTJ1242E Driver %1 has reported a %2 status
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RPTJ1244E The AgentCommandListener for %1 has encountered an exception while processing 

%2

RPTJ1245E Driver %1 has reported that it is no longer receiving messages from the workbench. 

The previous message received from this driver, %2 milliseconds ago, was %3. At 

present no commands have been sent to this driver.

Explanation: Schedule commands sent from the workbench to the agent computer were not received by 

the agent computer.

User response: Ensure that there is at least one successful test run, possibly with fewer virtual users, 

so that the maximum memory value for the agent is set correctly. Use more agent computers to run the 

schedule.

RPTJ1261E The ResponseHandler for %1 has encountered an exception while processing %2

RPTJ1270E Failure attempting to launch test execution.

RPTJ1271E The process executing the test has ended unexpectedly.

Explanation: The process that runs tests could not start, or it stopped before the test run ended.

System Action: The test run stops.

User response: Check the core files or the logs for further information on the process failure. If you are 

using Java Virtual Machine (JVM) arguments, check the argument syntax and try running tests without 

the arguments. Run the test inside a schedule.

45



Troubleshooting Guide

46

RPTJ1280E The communication path for returning test results from %1 has not been established. 

Check network connectivity between that machine and the workbench including any 

firewalls.

RPTJ1400I %1% %2/%3 files %4/%5 bytes deployed

RPTK0000I %1

RPTK1001E __PT_ACRONYM__ has detected the presence of an invalid Virtual Tester license 

key. If you have recently upgraded __PT_ACRONYM__, note that this is a new check 

performed by release 7.0.1 or later, and instructions for replacing invalid Virtual 

Tester license keys should have already been sent to you. You must replace all 

invalid Virtual Tester license keys before __PT_ACRONYM__ will allow execution of 

a schedule run that requires a Virtual Tester license. If you need further assistance, 

please contact your __VENDOR_NAME__ sales representative or Technical Support to 

replace the invalid Virtual Tester license key(s).

Explanation: Invalid Virtual Tester license key(s).

System Action: System will not execute schedule run(s) that require a Virtual Tester license if one is not 

available.

User response: You must replace all invalid Virtual Tester license keys. If you need further assistance, 

please contact your sales representative or Technical Support.

RPTK1016E The specified license server's version level is not compatible with this version of 

__PT_ACRONYM__.

Explanation: The specified license server's version level is not compatible with this version.
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System Action: Incompatible version.

User response: Check the license server's version.

RPTK1019E Unable to verify system time.

Explanation: The system time has been tampered with since the last successful license check.

System Action: Future license checks will automatically fail.

User response: Contact Technical Support.

RPTK1020E Unable to locate license directory.

Explanation: Unable to locate license directory.

System Action: Stop execution.

User response: Please verify that the license directory exists.

RPTK1021E License has expired.

Explanation: An expired license was found.

System Action: Request a license key from user.

User response: Enter a new license key.

RPTK1022E Invalid license file.

Explanation: A valid license was not found.

System Action: Request a license key from user.
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User response: Enter a valid license key.

RPTK1023E Unable to find a license supporting %1 virtual users.

Explanation: The currently installed license key(s) do not support enough VUs for this operation.

System Action: Request a license key from user.

User response: Enter another license key to enable more VUs.

RPTL0001W Unable to retrieve data from the test.

RPTL0002W Failed to store test data into annotations.

RPTL0003W Failed to attach the annotation to the test.

RPTL0004W Unable to open test annotation to read data.

Explanation: The test appears to be corrupted.

System Action: Attempts to open the test fail.

User response: Make sure your disk has enough space. If it does, try recreating the test from the 

recording.

RPTL0005W Failed to create a temporary file to save test data.
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RPTL0006W Failed to load test. Path %1 is invalid.

RPTL0007W Failed adding element from an un-registered feature %1.

RPTL0008E Cannot load a test created by a future version %1. Please upgrade your install.

RPTL0009I Test %1 is of an older version %2.

RPTL0010E Error creating metadata cache.

RPTL0011E Error reading metadata cache for %1.

RPTR0000W %1

RPTR0001W Failed to add annotation to execution history for file %1

RPTR0002W Unexpected error in data validity check of LoadTimeEObjectConsumer

RPTR0003W Failed to add properties to parent id %1
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RPTR0004W Failed to delete temp file %1

RPTR2001E Unexpected exception in container complete loader. Heap growth likely.

RPTR2003W Execution Variables - Output

RPTS1510E Unable to stop the agent communication service because of an error: %1

RPTS1001I Agent communication service listening on ports(%1)

Explanation: The agent communication service requires these local server ports to communicate with 

agents.

System Action: No system action is required.

User response: This message is for informational purposes only.

RPTX0001E The combination of transformer and feature you have selected is invalid. Transformer 

(%1) was not expecting data type (%2).

RPTX0002E The combination of feature and transformer you have selected is invalid. Feature 

(%1) was not expecting data type (%2) to be returned by transformer (%3).

RPTX0003E Transformer (%1) has experienced a fatal error. Additional information (%2).
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RPTX0004E Feature (%1) has experienced a fatal error. Additional information (%2).

RPTX0005E No class can be found for the specified transformer id (%1). Please check to make 

sure you have installed this transformer.

RPTX0006E Class definition missing. Please add jar that contains definition of (%1) to the 

classpath of the test project.

Explanation: Some requests or responses contain data that is encoded for Google Web Toolkit (GWT). To 

decode the data, Rational®  Performance Tester  requires access to the class definition.

User response: Add the JAR file that contains the class definitions to the classpath of the test project.

RPTX0007E The transformation raised a GWT serialization exception: %1

Explanation: The Google Web Toolkit (GWT) transformation could not be applied because of the indicated 

reason.

User response: Verify that the test elements containing the GWT encoded or decoded data are correct

RPTX0008E The Silverlight decoder raised an exception: %1

Explanation: The Microsoft Silverlight decoder did not work because of the indicated reason.

User response: Verify that the test elements containing the Silverlight encoded data are correct

RPTX0009E The Silverlight encoder raised an exception: %1
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Explanation: The Microsoft Silverlight encoder did not work because of the indicated reason.

User response: Verify that the elements containing the Silverlight decoded data are correct

RPTX0010E The GraniteDS transformer made an error when encoding or decoding: %1

Explanation: The GraniteDS encoder did not work because of the indicated reason.

User response: Verify that the elements containing the GraniteDS encoded or decoded data are correct.

RPXD0022W The time to extract references seems excessive. It was %1 milliseconds.

Explanation: It is taking a long time to extract data from your response for your references.

System Action: None.

User response: Examine each of the regular expressions for your references. Make sure they don't have .* 

with no qualifiers or other poorly formed constructs. When you write the regular expression in the test you 

can click verify to get an idea of how long it is taking to execute.

RPXE0061I Loop iteration started late by %1 millseconds

Explanation: A scheduled loop iteration started execution later than expected given the specified rate.

System Action: Execution continues along with attempt to catch up in order to maintain desired rate.

User response: Add additional users or agents to increase capacity in order to maintain desired rate.

RPXE5502E An exception occurred while logging an event to Jaeger.

Explanation: An error occurred when attempting to log an event to Jaeger. The event will not be available 

in Jaeger traces.
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System Action: Jaeger logging will continue for the next events.

User response: Contact support.

RPTX1010I Start of RPT  project resolve. Repository=<%1>, Bootstrap=<%2>

RPTX1011I Attempting to resolve asset=<%1>

RPTX1012I End of RPT  project resolve. No detected errors

RPTX1017I Downloaded asset %1 from remote repository, local asset created.

RPTX1018I Using local cached version of asset %1.

RPTX1019I RPT  testsuite=<%1> found the following dependencies=<%2>

RPTX1081E Exception occurred while uploading Mobile report.

Explanation: A low-level exception occurred uploading the mobile report. It is unexpected.

System Action: The RQM report will fail to upload.

User response: If possible take corrective action, otherwise contact support.

RPTX1082E An error occurred when generating the HTML/zip report.
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Explanation: The HTML generator for the Execution Report has failed.

System Action: No execution report uploaded into RQM results

User response: Ensure that the temporary directory is accessible on your file system.

RPTX2001E Adapter unable to start test because __PT_ACRONYM__ is already executing a test.

Explanation: The adapter received a request to start a test while another test on the adapter is in-

progress.

System Action: The adapter ignores the request to launch another test.

User response: Wait for the test which is currently executing on the adapter to complete, then re-initiate 

the launch.

RPTX2002E Error encountered parsing RQM adapter preferences: %1. Please enter proper 

credentials in the Eclipse Quality Adapter preference page (Windows->Preferences).

RPTX2003E Project <%1> could not be found during RQM import.

RPTX2004E Test log is unavailable, no test results returned to RQM.

RPTX2005E Statistics log is unavailable, no statistic results returned to RQM: %1

RPTX2006W Display unavailable, no __PT_ACRONYM__ HTML reports will be attached to RQM 

execution results.
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Explanation: The adapter requires access to a virtual display to generate HTML reports. The adapter was 

unable to successfully create a display so HTML reports may be unavailable.

System Action: HTML reports are not generated at the end of execution.

User response: If HTML reports are required, start the adapter with display access. Refer to 

documentation on how to start the adapter with a display.

RPTX2007I Start RQM Execution Request Project=%1 Name=%2

RPTX2008I Start RQM Import Request Project=%1

RPTX2009I End RQM Execution Request

RPTX2010I End RQM Import Request

RPTX2011E Unable to interpret RQM configuration file %1. If file was hand edited make sure 

parameters are the correct format. If you are unable to get this file into the correct 

format, please erase and re-configure.

RPTX2012E Invalid RQM connection parameter: %1. Adapter was not launched.

RPTX2013E Adapter was stopped while a test was executing. The results of this test may be 

unreliable.
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RPTX2014E Adapter was stopped while preparing to run an RQM script. There are no results for 

the attempted test script run.

RPTX2015E Testsuite '%1' or project '%2' does not exist. Ensure workspace started by adapter 

contains project and testsuite.

RPTX2016I %1

RPTX2017E %1 Reason: %2

RPTX2018W %1

RPTX2019I The RQM Adapter has been disconnected.

RPTX2020I The RQM Adapter has stopped.

RPTX2021E Unexpected error occurred while executing RQM test script.

RPTX2022E Unexpected error occurred while processing an import request from RQM.
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RPTX2023W Error occurred while update the run status back to the RQM server. This may cause 

the RQM test progress page to contain inaccurate data.

RPTX2024E Unable to attach the following file to the RQM results. This may cause the attached 

HTML report not to render correctly. File name: %1

RPTX2025E Error occurred while registering the adapter: %1.

RPTX2026E Error occurred setting the default adapter name. Please set the name in the Eclipse 

Quality Adapter preference page (Windows->Preferences).

RPTX2027W Multiple test runs were detected when the stop request was received from RQM.

RPTX2029W Was unable to perform stop request from RQM. Likely the run was already shutting 

down when the request came in.

RPTX2030I Request to stop the test is being delayed until the appropriate run state is reached.

RPTX2031I A request to stop the currently running test has been received by RQM.

RPTX2032I Successfully issue a stop command to the running test. Please wait for the test to 

end.
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RPTX2033E Error attempting to stop a test.

RPTX2034E Unable to create directory %1 no further information. Ensure user has permission to 

create directory in that location.

RPTX2035E Error occurred while attempting to automatically update pre-8.0 asset %1 for RQM 

execution.

RPTX2036E RQM remote resource access is not supported for pre-8.0 SOA assets. Please update 

your entire SOA project to 8.0 or greater before sharing.

RPTX2037E Launch was aborted: %1

RPTX2050E Unable to download remote asset %1 into local workspace. Remote repository %2. 

Ensure RQM system has connectivity to the remote repository and the file exists.

RPTX2051E Unable to browse %1 in remote repository %2. Ensure RQM system has connectivity 

to the remote repository and the directory exists.

RPTX2055E Error occurred reading the adapter connection file.

RPTX2056E Error occurred saving the adapter connection file.



Chapter 1. Troubleshooting Guide

RPTX2057E Unable to complete import operation because the specified path is not in the 

adapters workspace. Try specifying the only the project name.

RPTX2058E The specified script <%1> is not in the workspace currently being used by the adapter. 

You can only execute scripts which are in the adapters workspace.

RPTX2060E The script path specified by RQM does not seem to be valid. Please ensure the RQM 

test script has a script path which contains the project and script name.

RPTX2061W Run verdict is inconclusive because no performance requirements exist in the last 

user stage for the associated VU Schedule.

RPTX2062W Run verdict is inconclusive because there are zero performance requirements in the 

last user stage of the associated VU Schedule.

RPTX2063W No time range was generated for the user stage of the associated VU Schedule. 

Performance requirements reported to RQM will be based on the default time range.

RPTX2070E Error occurred while setting the RQM project area. Make sure a valid project area is 

specified on the Quality Manager Adapter preference page. The adapter is attempting 

to connect to RQM using the default project area.

RPTX2071E Error occurred while retrieving list of project areas. Please verify Quality Manager 

connection information. See error log for more details.
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RPTX2072E Error occurred calling for the web analytics dash-board link.

Explanation: Rational®  Performance Tester  could not open the external URL for the dashboard that 

references Rational Quality Manager records. This error occurs when a problem exists with the classpath 

for the result analysis.

User response: Ensure that Rational Quality Manager is version 4.0 or later and Rational®  Performance 

Tester  is version 8.3 or later. If the error log contains startup errors, resolve the errors and check whether 

the problem is resolved.

RPTX2073E Error occurred while translating RQM server execution variables to 

__PT_ACRONYM__.

Explanation: An unexpected error occurred while setting up execution variables.

System Action: Execution variables are unavailable during execution.

User response: Contact support if this error persists.

RPTX2074E Error connecting RTW  adapter and successful connecting RPT  adapter. This suggest 

RQM does not support RTW  script type introduced in 4.0.3. If RTW  adapter is not 

required it can get disabled by adding -DrtwStartAdapter=false in eclipse.ini.

Explanation: Error connecting RTW  adapter and successful connecting RPT  adapter. This suggest RQM 

does not support RTW  script type introduced in 4.0.3. If RTW  adapter is not required it can get disabled by 

adding -DrtwStartAdapter=false in eclipse.ini.

User response: Use a RQM system supporting RTW  script type. Add -DrtwStartAdapter=false in eclipse.ini 

to disable RTW  script type. To import and execute RTW  assets under the RPT  adapter script type also add 

-DrptAvoidRQMImportFiltering in eclipse.ini
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RPTX2075E Unable to interpret expression <%1> from RQM control file <%2>. Ignoring. Reason <

%3>

Explanation: The RQM control file is of an invalid format.

System Action: The control file instruction will be ignored.

User response: Change the file so it follows the specified format supplied by support.

RPTX2077E Unable to browse to <%1>. Make sure it exist on the shared location.

Explanation: The project referenced does not exist on the shared location.

System Action: The RQM execution will stop.

User response: Ensure all required projects exist on the shared location.

RPWF0011E Error occurred while completing test generation

RPWF0012E Error occurred while processing a packet at test generation

RPWF0021E WSDL Exception raised while processing WSDL source

RPWF0032E Error while generating test from Axis recording

RPWF0051E Error occurred while setting classpath entry for recorder
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RPWF0052E I/O exception occurred while resolving keystore or truststore path

RPWF0056E Error occurred while launching web services HTTP proxy

RPWF0066E Error occurred while launching axis client recorder agent

RPWF0071E Exception thrown while creating a wizard page control

RPWF0072E Exception thrown while parsing URL: %1

RPWF0074E Exception thrown while finishing the axis recording wizard

RPWF0075E Exception thrown while looking for an available port

RPWF0076W Exception thrown while adding SOA Tester certificate to the trustore %1

RPWF0081W A proxy authorization %1 is used without any proxy

RPWF0082W No free name can be found; reusing %1
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RPWF0083E Resource file %1 not found in workspace %2

RPWF0084E Workspace location cannot be determined

RPWF0085E Cannot retrieve the operation name from the envelope %1

RPWF0101E Core exception thrown using org.eclipse.debug.core plugin

RPWF0102E Exception thrown during launch configuration update

RPWF0103E Exception thrown while resolving a bundle entry path

RPWF0104E Exception thrown while identifying localhost IP address

RPWF0111E Exception thrown while creating a substitution: %1

RPWF0112E Exception thrown while creating a reference: %1

RPWF0121W Unknown format. Skipping the test generation for: %1
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RPWF0122W Skipped call: %1

RPWF0123W Skipped request: It could be that provided password was not ok

RPWF0124W Attachments not generated.

RPWF0130W Could not find project for URI: %1

RPWF0131W Loading XSD Schema failed: %1

RPWF0132E Error while generating test from Generic Service Client: Can't show wizard

RPWF0140E An error has occurred: %1

RPWH0007W Unhandled Security Algorithm '%1'

RPWH0009W Unable to serialize data

RPWH0010W Unable to deserialize data
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RPWH0012E Unable to open editor for '%1'

RPWH0014E Parse Error in '%1'

RPWH0015E Unable to create resource '%1'

RPWH0016E Failed to export source text '%1'

RPWH0017E A connection error occurred on '%1', please check the URL or the network 

configuration

Explanation: A connection error occurred.

System Action: URL can not be reached, action is aborted.

User response: Check the URL or the network configuration.

RPWS0001E Exception raised during data harvest execution

Explanation: Reference can't be performed.

System Action: Reference is not performed: get empty data.

User response: Check the corresponding reference.

RPWS0002E Exception raised during data substitution execution
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Explanation: Substitution can't be performed.

System Action: Substitution is not performed: write recorded data.

User response: Check the corresponding substitution.

RPWS0003E Exception raised on harvest data management

Explanation: Reference can't be performed.

System Action: Reference is not performed: get empty data.

User response: Check the corresponding reference.

RPWS0004E Exception raised on substitution data management

Explanation: Substitution can't be performed.

System Action: Substitution is not performed: write recorded data.

User response: Check the corresponding substitution.

RPWS0005E Exception raised during WebSocket read action

Explanation: Read action can't be performed.

System Action: No data are receive.

User response: Check the application side, may be the server closes the connection.

RPWS0006E Exception raised during WebSocket write action

Explanation: Write action can't be performed.



Chapter 1. Troubleshooting Guide

System Action: No data are sent.

User response: Check the application side, may be the server closes the connection.

RPWS0007E Unable to get WebSocket connection

Explanation: WebSocket connection information is wrong.

System Action: No data will be receive or sent on this connection.

User response: Check the WebSocket connection, may be the test is corrupted.

RPWS0008E Unable to read from a closed connection

Explanation: WebSocket connection is closed.

System Action: No data will be sent on this connection.

User response: Check why the WebSocket server closed connection.

RPWY0002E An exception occurred in %1

Explanation: An exception was detected.

System Action: Current action is aborted.

User response: Check the cause of the exception.

RPWY0003I Information: %1 (%2)

RPWY0004W Warning: %1 (%2)
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RPWY0005E An error occurred while importing external schema %1

RPWY0006E Unable to correlate automatically

RPWY0007E An exception %1 occurred in %2

Explanation: An exception was detected.

System Action: Current action is aborted.

User response: Check the cause of the exception.

RPWZI0002E Exception raised during WebSocket connection creation.

Explanation: The workbench could not create a connection for WebSocket elements in split test.

System Action: No connection are created by the workbench.

User response: The user need to create manually the connection, or to get the upgraded HTTP request in 

the split selection.

RPXD0001E Unknown Segment Offset/Length for Segmented Dataset: %1

RPXD0002E Bad Dataset Mode: %1

RPXD0003E Dataset not initialized: %1
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RPXD0004E End of non-wrapped dataset reached: %1

RPXD0005E Dataset with multiple Equivalence Classes cannot be segmented

RPXD0006E segmented DatapoolMap null: %1

RPXD0007F No registered data correlation handler for this IKAction

RPXD0017W Pattern matching failed for: regex (%1) str (%2)

RPXD0018E Skipping substitution, reference value was null. original string: (%1) offset: (%2)

RPXD0019E Data Correlation: Failed Substitution\nReference[%1]\nSubstitution[%2]\n\nDetails:

\n\nA failed reference occurred in a prior request. Since the reference named [%3] 

was null, we were unable to substitute a new value for the substituter named [%4], 

original string [%5] at offset [%6] and this request may have failed. Please inspect 

prior requests for the reference failure and corrective guidance to avoid this in the 

future.\n\nFor more information search the help for the data correlation topics.

Explanation: A reference for an expected data substitution is null.

System Action: None.

User response: To find the failed reference, open the test and go to the substitution site. Right-click the 

substitution site and select Go To > Reference. When troubleshooting failed references, start with the 

first error message. The first failed reference can cause subsequent failed references. Search the test 

log "for unable to extract" to find the first error message.\n\nExamine the request that generated the 
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response. The request contains a value that might need to be correlated. For example, the request might 

contain a username that must be unique to play back the test successfully. In that case, use a dataset 

to provide a list of unique username values. You might need to manually correlate a value by using the 

Test Data Sources view. Values that typically are correlated include timestamps, dates, ids, and other 

alphanumeric strings.\nIf you no longer need the data correlation mentioned in the message, remove that 

data correlation from the test.

RPXD0020E Data Correlation: Failed Extraction\nReference[%1]\n\nDetails:\n\nWe were unable 

to extract the value for the reference named [%2], with the regular expression [%3]. 

This could mean a later request will fail. Please compare the response in the test log 

to the corresponding response in the test to look for differences that could cause 

this failure. These differences are often due to problems with the request and may be 

caused by missing or incorrect correlations.\n\nFor more information search the help 

for the data correlation topics.

Explanation: The response received during playback is different from the response received when the test 

was recorded. The data correlation code was unable to use the regular expression expected value.

System Action: None.

User response: Examine the request that generated the response. The request contains a value that might 

need to be correlated. For example, the request might contain a username that must be unique to play 

back the test successfully. In that case, use a dataset to provide a list of unique username values. You 

might need to manually correlate a value by using the Test Data Sources view. Values that typically are 

correlated include timestamps, dates, ids, and other alphanumeric strings. \nIf you no longer need the 

data correlation mentioned in the message, remove that data correlation from the test.

RPXD0021E Dataset %1 is accessed using different dataset modes by different tests.

RPXD0021W Setting variable %1 to value %2.



Chapter 1. Troubleshooting Guide

RPXE0001W %1

RPXE0010W Engine shutdown problem joining workers

RPXE0011W Failed to report exception

RPXE0012W Schedule failed to load

RPXE0013W Unable to create test

RPXE0014W Setting log level to %1

RPXE0015W Attempt to add object to Schedule which is not a UserGroup

RPXE0016W Virtual User %1 experienced error %2

RPXE0017W Connect timeout for action %1 (%2) user %3

RPXE0018W Read timeout for action %1 (%2) user %3
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RPXE0019W Connect exception for action %1 (%2) user %3

RPXE0021W Read exception for action %1 (%2) user %3

RPXE0023W Iterating over keys exception

RPXE0024W CancelledKeyException

RPXE0025W NullPointerException

RPXE0027W UserGroup exception

RPXE0028W User Group %1 does not implement createTesterWorkload()

RPXE0029W Worker caught throwable

RPXE0030W Connection leak, I/O state %1

RPXE0031W Exception finishing connection for action %1 (%2) user %3
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RPXE0033W Finish read get buffer interrupted for action %1 (%2) user %3

RPXE0035W Finish read exception for action %1 (%2) user %3

RPXE0036W Engine thread startup exception

RPXE0037W Engine request to report exception

RPXE0038W Exception creating cache file, cacheFileName: %1, extension: %2, dir: %3

RPXE0039W User %1 experienced exception %2

RPXE0040W User %1 caught exception trying to report severe error.

RPXE0041W Engine hard stop after %1 second timeout

RPXE0042I %1 received request to stop

RPXE0043I Forced stop of action %1
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RPXE0044W No IP address was found for the local host

RPXE0045W Ignoring invalid network interface %1

RPXE0046W Could not find any usable network interfaces

RPXE0047E SyncPointSubsystem Unknown sync point: %1

RPXE0048W %1 STOPUSERS users=%2 stagger=%3 timelimit=%4 active users=%5

RPXE0049W %1 had %2 non-sampled users asked to stop active users=%3

RPXE0050W %1 had %2 sampled users asked to stop

RPXE0051W %1 after wait for compliance active users=%2 target=%3

RPXE0052W %1 abandon user %2

RPXE0053W %1 abandoned %2 users
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RPXE0054W %1 end stop %2 users SUCCESS active users=%3

RPXE0055W %1 end stop %2 users FAIL active users=%3

RPXE0056W %1 occurred in %2. Message: %3

RPXE0057E Exception while reading test variable initialization file: %1

RPXE0058E Exception while initializing virtual users test variables.

RPXE0059E Unable to get Kerberos ticket from KDC for server %1.

RPXE0060E Failed to load test from '%1' due to exception: %2

Explanation: While trying to find and load class files required to execute the test a problem was 

encountered.

User response: See exception description for failure reason.

RPXE0100W %1 terminated due to exception: %2

RPXE0102W IKAction: %1 (%2) caught Exception in preFinish() for %3 (%4)
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RPXE0103W IKAction: %1 (%2) caught Exception in postFinish() for %3 (%4)

RPXE0104W KernelChannel connect(), exception while trying to bind to local address %1: %2

RPXE2501E An error occurred while attempting to handshake with the server using protocol %1 

and cipher suite %2. This type of failure is often related to a mismatch between the 

requested protocol or cipher suite and the ones the server is expecting or may be 

related to a server's request for a client digital certificate. If the server is configured 

to accept only 256-bit ciphers, contact __VENDOR_NAME__ Support for information 

on US export restrictions related to the exportation of strong encryption. Playback of 

tests utilizing these ciphers is not supported.

Explanation: An SSL connection between a client and server is set up by a handshake, the goals of which 

are: To satisfy the client that it is talking to the right server (and optionally visa versa). Also, for the parties 

to have agreed on a cipher suite, which includes which encryption algorithm they will use to exchange 

data. These goals were not achieved.

System Action: Execution ends because a secure connection cannot be established with the server.

User response: If the server requires a client digital certificate work with the server administrator to obtain 

one. If the server requires strong ciphers work with customer support to obtain the required and restricted 

ciphers.

RPXE2550E The digital certificate RCS file '%1' was not found or was corrupt: %2

RPXE2552I digital certificate alias

RPXE2900E The server rejected the client's digital certificate.
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RPXE2901W The server closed the connection abruptly. This is probably due to an overloaded 

server or to a problem negotiating a digital certificate or cipher suite. Check the web 

server's SSL error log for more details.

RPXE4000W Schedule or Test not found. May not have compiled. - %1

RPXE4001E Runner Exception occurred

RPXE4002E Communications Error: Invalid Logging Level

RPXE4003E Communications Error: Invalid TestLog Level for %1 events

RPXE4004E Communications Error: Invalid Statistics Level or Interval

RPXE4005E Runner Exception occurred - See problem determination log

RPXE4006E Communications Error: Invalid Dataset information

RPXE4007E Communications Error: No communication from the workbench in %1 milliseconds. 

For more information, see the Troubleshooting section of the online help.
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RPXE4008E Attempt to change statistic interval ignored.

RPXE4008I Think: requested time %1 milliseconds, actual time %2 milliseconds

RPXE4009I Delay: requested time %1 milliseconds, actual time %2 milliseconds

RPXE4010I Schedule completed. See Performance Report, Verification Points Report, and/or 

Percentile Report to further evaluate the results of this run according to your success 

criteria.

RPXE4011E Communications Error: Invalid Stop timeout

RPXE4013I Additional events from %1

RPXE4014E Communications Error: Invalid RunStagger information for %1 (pairCount)

RPXE4015E Communications Error: Invalid RunStagger information for %1 (pair %2)

RPXE4016E Failed to start users for user group: %1.
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RPXE4017I Additional execution history events from %1 are available, but they have been stored 

separately upon user request. See file %2. Refer to the most current version of the 

product release notes for information on how to access and view them.

RPXE4018E Failed to write message to workbench [%1]

RPXE4019E Failed to remove users for user group: %1.

RPXE4020E Failed to add users for userGroup: %1 numUsers=[%2] startId=[%3]

RPXE4021E Failed to add users because the runner is not in a runnable state.

RPXE4022E failed to add desired number of users

RPXE4023E failed to reach target number of users ramping down

RPXE4024E not runnable or command failed

RPXE4025E failed to set the DataView state of user %1[%2] to %3.

RPXE4026E DataView command %1 is not yet implemented.
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RPXE4027E DataView command %1 is not recognized.

RPXE4028E MessageEventFilter command parsing error in token %1[%2] of command [%3]

RPXE4029E The testLog message event filter specified by [%1] cannot be constructed. This filter 

element will be ignored.

RPXE4050I Operating System Info: name [%1] architecture [%2] version [%3]

RPXE4100W Cannot open execution history cache file [%1], execution history will not be cached

RPXE4101E Error closing execution history cache file [%1]

RPXE4102E Error reading %1 bytes from execution history cache file [%1]

RPXE4103E Error writing %1 bytes to execution history cache file [%2]

RPXE4104E Error opening execution history cache file [%1] for reading

RPXE4105E Error testing execution history cache file [%1] for available input
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RPXE4106E Unexpected EOF reading %1 bytes from execution history cache file [%2]

RPXE4107E Exception processing execution history event

RPXE4108E Error reading execution history cache file [%1]

RPXE4109E Error writing to TestLog cache file [%1]

RPXE4110E Error closing TestLog cache file [%1]

RPXE4111W Cannot open testLog cache file [%1] for random access writing, the testLog may 

contain bad data.

RPXE4112W Error removing testLog event from cache file [%1]. Writing %2 bytes at offset %3.

RPXE4120E Error writing to TestLog [%1]

RPXE4150E Error opening execution history annotation file [%1]

RPXE4151E Error writing %1 bytes to execution history annotation file [%2]
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RPXE4152E Error flushing/closing history annotation file [%1]

RPXE4153E Error deleting history annotation file [%1]

RPXE4200W Warning: Statistics delivery thread running behind statistics interval by %1 

milliseconds

RPXE4201W Warning: Statistics delivery thread over slept by %1 milliseconds

RPXE4202E Error: Statistics delivery thread over slept by %1 milliseconds

RPXE4203E Error: Statistics collection time too long: %1 bytes %2 milliseconds

RPXE4204W Warning: Statistics collection time too long: %1 bytes %2 milliseconds

RPXE4205E Error: Statistics write time too long: %1 bytes %2 milliseconds

RPXE4208E Error: Could not create agent measurements file %1.

Explanation: It is not possible to create a file on the file system.

System Action: Unable to create a file. The agent measurements will not be available.
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User response: You do not have the permissions on your file system or it is full.

RPXE4209I Error: Statistics collection thread was interrupted

Explanation: An error occurred which caused the interruption of the statistics collection.

System Action: Statistics may be incomplete.

User response: Run the test again.

RPXE4210E Error: A severe error occurred when processing statistics.

Explanation: An exception occurred on the agent while processing statistics and/or sending them to the 

server.

System Action: Statistics will be incomplete.

User response: Contact support.

RPXE4211E Error: A severe error occurred when sending statistics.

Explanation: An exception occurred on the agent while sending statistics to the server.

System Action: Statistics will be incomplete.

User response: Contact support.

RPXE4212E Error: A severe error occurred when closing statistics.

Explanation: An exception occurred on the agent while completing the statistics processing.

System Action: Statistics may be incomplete.

User response: Contact support.
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RPXE4213E Statistics sub-system error: %1

Explanation: A severe error occurred during writing to the agent measurements file.

System Action: The agent detailed measurements will not be available.

User response: Start a test execution again.

RPXE4214W Statistics sub-system warning: %1

Explanation: Warning message to the user during writing to the agent measurements file.

System Action: The agent detailed measurements may be affected by a problem.

User response: Fix the problem given by the message or contact support.

RPXE4215E Statistical counter descriptors file not found: %1.

Explanation: Unable to find the counter descriptors file in the deployment directories.

System Action: Statistics will not be available.

User response: Start the test again, contact support if the problem persists.

RPXE4215I Statistics sub-system message: %1

Explanation: This message is displayed in debug mode.

System Action: No action.

User response: You can report this message to the support.
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RPXE4216E Problem in statistical counter descriptors file: %1.

Explanation: The counter descriptors file has a problem.

System Action: Statistics will not be available.

User response: Start the test again, contact support if the problem persists.

RPXE4217E Submitted value %1 is out of range of allowed values for the counter type %2.

Explanation: The value is out of the limits of the counter.

System Action: Measurements and statistics for the specified counter will not be available.

User response: If you are a protocol developer, fix the problem. Otherwise, contact support.

RPXE4218E In order to use this method, the runtime type of the counter must be either STATIC or 

RATE.

Explanation: A protocol is using a legacy API to change the value of a counter.

System Action: Measurements and statistics for the specified counter will be inaccurate.

User response: If you are a protocol developer, use a runtime counter type to STATIC or RATE. Otherwise, 

contact support.

RPXE4219E Mismatch between runtime type %1 and static counter type %2.

Explanation: The type of the counter in runtime and in the statistic definition do not match.

System Action: The runtime type will be applied.
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User response: If you are a protocol developer, change the declared counter type, or the runtime type. 

Otherwise, contact support.

RPXE4220E No static declaration found for counter %1.

Explanation: Unable to find a definition for the counter.

System Action: The counter values will be ignored.

User response: Add a definition for the counter, or use an undeclared counter.

RPXE4221E Attempt to create an undeclared counter %1 (type %2) over a declared counter of a 

different type (%3).

Explanation: An attempt to create an undeclared counter was made, but a counter declaration with 

another type already exists.

System Action: The undeclared counter values will be ignored.

User response: Use another path for the undeclared counter that does not conflict with the existing 

declared counter.

RPXE4900I Test execution completed with no reported problems

RPXE4901I %1 ERROR verdicts reported

RPXE4902I %1 FAIL verdicts reported

RPXE4903I %1 INCONCLUSIVE verdicts reported
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RPXE4904I All reported verdicts PASSed

RPXE4905I %1 ERROR verdict reported

RPXE4906I %1 FAIL verdict reported

RPXE4907I %1 INCONCLUSIVE verdict reported

RPXE4908I %1 FAIL verdict roll-up

RPXE4909I %1 ERROR verdict roll-up

RPXE4910I %1 INCONCLUSIVE verdict roll-up

RPXE4911I %1 PASS verdict roll-up

RPXE4912I %1 ERROR verdicts reported from driver %2

RPXE4913I %1 FAIL verdicts reported from driver %2
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RPXE4914I %1 INCONCLUSIVE verdicts reported from driver %2

RPXE4915I %1 ERROR verdict reported from driver %2

RPXE4916I %1 FAIL verdict reported from driver %2

RPXE4917I %1 INCONCLUSIVE verdict reported from driver %2

RPXE4918I duration

RPXE4920I %1 was successfully invoked. This does not indicate the pass/fail verdict of the test 

itself, only that the invocation of the test was successful. Expand to inspect verdicts.

RPXE4921I %1 was invoked. This does not indicate the pass/fail verdict of the test itself, only 

that the invocation of the test was successful. No verdicts will be reported from the 

test.

RPXE4930I The %1 testLog level was pushed from %2%3 to %4%5.

RPXE4931I The %1 testLog level was popped from %2%3 to %4%5.
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RPXE4932I The %1 testLog level was changed from %2%3 to %4%5.

RPXE4940I Transaction [%1] started %2 milliseconds after start of test run.

RPXE4941I Transaction [%1] stopped %2 milliseconds after start of test run. Elapsed time: %3 

milliseconds.

RPXE4942I Transaction [%1] aborted.

RPXE4944W Transaction [%1] is already started.

RPXE4945W Transaction [%1] has not been started.

RPXE4948W Execution Variables - Input

RPXE4950I Null user group name.

RPXE4952E Unable to find target loop named '%1'. Error handler did not complete properly.

Explanation: The loop name specified in the loop handler does not exist.

System Action: The user will not follow the loop error handler and will continue execution at the next 

action.

89



Troubleshooting Guide

90

User response: Change the loop handler to point to an existing loop.

RPXE5301E Error encountered while loading Native Library: %1

RPXE5305E A required customer-supplied file was not found. Please check the "external_files" 

folder and your installation instructions for: %1

RPXE5330E Unable to apply dataset swap: %1

Explanation: An error occurred attempting to parse the data set swap command-line option.

System Action: The data set swap will not occur.

User response: See the command-line usage to ensure the command syntax is correct.

RPXE5500W Unable to apply Open Tracing context. The root Jaeger span will be unparented. %1

Explanation: An error occurred when attempting to create an Open Tracing span context from the 

properties starting with OPENTRACING_CTX_.

System Action: Jaeger logging will still occur but the root span will be linked to a parent span.

User response: Make sure the content of properties starting with OPENTRACING_CTX_ is correct.

RPXE5501W Transaction times for this run do not include failing transactions, according to 

workbench Test Execution preferences.

Explanation: A failing transaction will not be added to stats. This will only be logged once per transaction, 

but multiple instances may have failed.

System Action: Execution will continue as normal. This is not an error condition.
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User response: If this behavior is not desired, uncheck preferences at Test > Test Execution.

RRIT0001E Environment variable INTEGRATION_TESTER_AGENT_HOME not set to Rational® 

Integration Tester  Agent installation location, or does not contain expected 

RunTests(.exe) program.

Explanation: The test execution cannot find the Rational®  Integration Tester  Agent.

System Action: None.

User response: Set the environment variable INTEGRATION_TESTER_AGENT_HOME to point the root 

installation directory of the Rational®  Integration Tester  agent. This must be done on each location used 

in a schedule.

RRIT0002E Error unzipping __IT_PRODUCT_NAME__ project.

Explanation: The __IT_PRODUCT_NAME__ project cannot be deployed.

System Action: None.

User response: Verify that there is enough disk space on the executing location.

RRIT0003E __IT_PRODUCT_NAME__ library not found.

Explanation: The library required to communicate with the __IT_PRODUCT_NAME__ agent is missing in 

the installation.

System Action: None.

User response: Contact your support.

RRIT0004E Error processing messages received form the __IT_PRODUCT_NAME__ client.
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Explanation: A communication error has occurred with the __IT_PRODUCT_NAME__ agent.

System Action: None.

User response: Try again, contact your support if problem persist.

RRIT0005E Some tag values are missing.

Explanation: A value cannot be assigned to a tag defined in an __IT_PRODUCT_NAME__ test during 

execution.

System Action: None.

User response: Verify that each tag of each __IT_PRODUCT_NAME__ test maps to a variable in the 

schedule or compound test.

RRITUI1002W Open __IT_PRODUCT_NAME__ resources has been disabled in Test > 

__IT_PRODUCT_ACRONYM__ Integration preferences

Explanation: User as disabled __IT_PRODUCT_NAME__ resource but want to open this kind of resource.

System Action: None.

User response: Open Test > __IT_PRODUCT_ACRONYM__ Integration preference and enable open 

resources by checking __IT_PRODUCT_NAME__ is installed on this machine .

DCRC0001E Missing message for log entry '{0}' in class: {1}

DCRC0002E Cannot get Log key '{0}': SecurityException raised

DCRC0003E Cannot initialize Log key '{0}'
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DCRC0008W Warning: field '{0}' is not defined in class: {1}

DCRC0009W Warning: cannot get check message versus log key mapping for '{0}' of class {1}, 

SecurityException raised

DCRC0010E Unexpected exception, please check Error Log view: {0}

DCUI0001E unexpected exception

Explanation: An exception that could not be handled occurs during processing.

User response: Close rule editor and report exception to product support.

DCUI0003E Error getting persistent property '{0}'

DCUI0004E Error setting persistent property '{0}'

DCUI0006E Cannot reload resource '{0}'

DCUI0007W Failed to encode model to clipboard.

DCUI0008W Failed to decode model from clipboard.
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DCUI0009E None of the attribute providers own attribute id '{0}'.

Explanation: Rule file refer to an unknown rule attribute id. File may be edited on a system having more 

protocol extension rather than current one.

User response: Rule file should not be edited on this product installation.

DCUI0010E Missing IRuleUIProvider extension point for '{0}'

Explanation: Rule file refer to a rule that is unknown on this product installation.

User response: Rule editor is able to display that rule on the tree but not able to edit it contents.

DCUI0011E Missing IConditionUIProvider extension point for '{0}'

Explanation: Rule file refer to a rule condition that is unknown on this product installation.

User response: Rule editor is able to display that rule condition on the tree but not able to edit it contents.

DCUI0012E Cannot save editor '{0}'

DCUI0013E Missing IRulePassUIProvider extension point for '{0}'

Explanation: Rule file refer to a rule pass that is unknown on this product installation.

User response: Rule editor is able to display that rule pass on the tree but not able to edit it contents.

DCUI0014E Missing IRuleArgumentUIProvider extension point for '{0}'
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DCUI0015E Missing IRuleArgumentContainerUIProvider extension point for '{0}'

DCUI0016E Try rule failed

DCUI0017E Try rule failed: '{0}'

DCUI0998E Cannot load file '{0}'

Address already in useAddress already in use.

Explanation: Typically, this error message is displayed when all available TCP/IP ports have been 

exhausted.

System Action: None.

User response: 

• If the A schedule, in this context, is used to refer to both VU Schedule  and Rate Schedule  contains 

loops, move the loops into tests. If a A schedule, in this context, is used to refer to both VU 

Schedule  and Rate Schedule  contains loops, at the beginning of a loop iteration each virtual user 

closes existing connections and opens new connections. This can cause the agent computer to 

exhaust all available TCP/IP ports. If a test contains loops, virtual users attempt to re-use existing 

connections. Re-use of existing connections can take advantage of keep-alive connections.

• Increase the number of TCP/IP ports available. The number of TCP/IP ports on a Windows™ 

computer is limited to 5000 by default. To increase the number of TCP/IP ports available on a 

Windows™  computer:

1. Create the following Registry key: HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet

\Services\Tcpip\Parameters\MaxUserPort. This key does not exist by default.

2. Specify the type as DWORD.
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3. Set the value to 65000.

4. Reboot the computer.

Browser profile in useYour browser profile is already in use. You must close the browser or select another 

browser from Application to Record in Preferences.

Explanation: The browser configured for recording is already running, or a lock file exists that prevents the 

browser from running.

System Action: The test run does not start.

User response: 

• Close the browser configured for recording, and record again or select another web browser in the 

Test From Recording  wizard.

• Search for and remove any lock  files from the browser profile directory.

Cannot open testCannot open the test testname  because it contains the following features that are not 

installed: featurename.

Explanation: The test that you are attempting to open requires the installation of one or more protocol 

extensions.

System Action: The test is not opened.

User response:  To install a protocol extension: 

1. Close the product.

2. Launch IBM®  Installation Manager.

3. Click Modify.

4. Navigate to the Modify Packages  window.

5. Select the required protocol extensions.

6. Follow the steps in the wizard to complete the installation of the protocol extensions.

 A protocol license key is required to use protocol extensions other than HTTP. See the installation guide 

for more information on managing protocol license keys. 



Chapter 1. Troubleshooting Guide

Connection closedWeb server computername  unexpectedly closed the connection while in the process 

of retrieving URI URIname

Explanation: This message is displayed when the HTTP server being tested has become too busy and has 

closed the connection without completing the response.

System Action: None.

User response:  If you receive this error message multiple times for a particular HTTP request or when the 

server is not under load, contact the administrator of the server under test to determine potential causes 

of the behavior. 

Dataset accessed using different modesDataset datapoolname  is accessed using different dataset modes by different tests.

Explanation: Two tests are accessing the same dataset. These two tests use different access methods 

for the dataset.

System Action: None.

User response:  Examine your tests to find the dataset mentioned. Check the access mode for the 

dataset by double-clicking the dataset name in the test. The access mode will be Random, Shuffled, or 

Sequential. Ensure that the access mode is the same for all tests that use the dataset. 

Error binding to portError Binding to Port:portnumber  Exception: java.net.SocketTimeoutException: 

Accept timed out.

Explanation: The listener port for HTTP recording is in use by another application.

System Action: None.

User response:  Change the listener port for HTTP recording to a port that is not in use by another 

application. See Changing HTTP recording preferences  on page  for more information. On the 

Browsers Recording  preferences page, edit the value of the Proxy Recorder Local Port  field. 
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No local agent controllerLocal computer is not running the Agent Controller.

Explanation: The agent controller coordinates schedule playback between the workbench and agent 

computers. The agent controller is not running on the local computer.

System Action: No tests run.

User response:  Make sure that the agent controller is installed and running on the workbench computer. 

On Windows™  computers, the agent controller is a process called ACWinService. On Linux™  computers, 

the agent controller is a process called RAServer. 

To start the agent controller, do one of the following steps:

• On Windows™, at a command prompt, enter this command:

net start "IBM Rational Agent Controller"

• On Linux™, change to the directory AgentController/bin  in the product installation directory; 

then enter this command:

./RAStart.sh

Performance Test Errors were found in the projectPerformance Test Errors were found in the project.

Explanation: This error can occur when workspaces are shared on different computers or when the 

installation location of the product has changed since the project was created.

System Action: None.

User response:  To work around this error, clean up the Java™  build path and the generated Java™  source 

files. 

1. Click Window  > Open Perspective  > Resource  to open the Resource  perspective.

2. Select the project in the Project Explorer  view, and then right-click and select Properties  to view the 

project properties.

3. Select the Java Build Path  property.

4. Click the Libraries  tab.
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5. Select each entry that is displayed with a red X and remove that entry from the build path. If a 

referenced library is pointing to user-specific libraries that have moved or are not present, edit the 

entry so that it points to the correct location. Do not remove entries for user-specific libraries.

6. Click OK.

7. Expand the src  folder in the project.

8. Remove all generated Java™  source files that are displayed with a red X. If the source file is user-

specific, then edit the build path to point to the correct dependent libraries.

Test run abortedExecution failure. No status received from location computername  in interval 

seconds.

Explanation: The workbench has lost communication with one or more agent computers.

System Action: The test run stops.

User response:  For each agent computer: 

• Check that the playback Java™  process is running. If it is still running, the problem might be on the 

workbench computer. Stop the Java™  process and all related typeperf and vmstat processes.

• Examine the problem determination log for error messages or exception messages.

• If the playback Java™  process is not running, search for javacore.*  files. The contents of these 

files might help you determine the cause of the problem.

• Run tests again and monitor the memory size of the playback Java™  process. If the playback Java™ 

process is consistently running at its maximum heap size, the process might not have enough 

memory.

 If the problem is not on an agent computer, check that the workbench computer has sufficient memory. 

To increase the available memory, either increase the workbench heap size or reduce the level and 

amount of execution history. 

Test run aborted due to errorVirtual users have exited prior to stage completion.

Explanation: In a schedule with multiple stages, at the end of a stage that is configured with n  virtual 

users, there were fewer than n  virtual users running. The schedule did not assign enough work to the 

virtual users to keep them active for the duration of the stage, or the virtual users stopped because of 
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an a different error. The workload problem can occur if you use multiple stages but do not enclose the 

workload in an infinite loop.

System Action: The test run stops.

User response:  On the workbench computer, examine the workload for each user group in the schedule. 

Check that the entire workload is inside an infinite loop, so that the virtual users always remain active 

regardless of the stage duration.  If the tests already use infinite loops, then the agent computers might 

have encountered errors while running tests. To determine why virtual users stopped before the stage 

completed: 

• Examine the test log for error or exception messages.

• Increase the test log level and decrease the number of users. Try running the schedule again. 

Examine the test log for error or exception messages.

• Simplify the workload by running one user in one stage. Check to see whether the single user takes 

the expected amount of time to complete all actions. If not, examine the test log and problem 

determination log for error or exception messages.

Testgen completed with warningsTestgen completed with warnings.

Explanation: The response data has been truncated according to the setting in the HTTP Test Generation 

preferences.

System Action: None.

User response:  To adjust how response data is truncated, click Window  > Preferences  > Test  > Test 

Generation  > HTTP Test Generation  > Test Generation Options, and edit the value of the Save only the 

first 4KB of responses larger than  field. 

Variable not initializedVariable variablename  has not been initialized for this test.

Explanation: A variable was used in a test, but the variable had never been initialized to a value.

System Action: Depending on the value of the Run-time error if variable not initialized  setting, the system 

will either do nothing, issue a warning, issue a test log error, or exit the test.
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User response:  Check the variable to determine where the initialization should have happened. Make sure 

that the test that contains the initialization of the variable occurs before the test trying to use the variable. 
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Chapter 2. Notices

This document provides information about copyright, trademarks, terms and conditions for the product 

documentation.

© Copyright IBM Corporation 2001, 2016 / © Copyright HCL Technologies Limited 2016, 2021

This information was developed for products and services offered in the US.

IBM®  may not offer the products, services, or features discussed in this document in other countries. 

Consult your local IBM®  representative for information on the products and services currently available 

in your area. Any reference to an IBM®  product, program, or service is not intended to state or imply that 

only that IBM®  product, program, or service may be used. Any functionally equivalent product, program, or 

service that does not infringe any IBM®  intellectual property right may be used instead. However, it is the 

user's responsibility to evaluate and verify the operation of any non-IBM®  product, program, or service.

IBM®  may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You can send 

license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119

Armonk, NY 10504-1785

US

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM® 

Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION  PROVIDES THIS PUBLICATION "AS IS" WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 

PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in certain 

transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically 

made to the information herein; these changes will be incorporated in new editions of the publication. 
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IBM®  may make improvements and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice.

Any references in this information to non-IBM®  websites are provided for convenience only and do not in 

any manner serve as an endorsement of those websites. The materials at those websites are not part of 

the materials for this IBM®  product and use of those websites is at your own risk.

IBM®  may use or distribute any of the information you provide in any way it believes appropriate without 

incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 

exchange of information between independently created programs and other programs (including this 

one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119

Armonk, NY 10504-1785

US

Such information may be available, subject to appropriate terms and conditions, including in some cases, 

payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by 

IBM®  under terms of the IBM®  Customer Agreement, IBM®  International Program License Agreement or 

any equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. 

Actual results may vary.

Information concerning non-IBM®  products was obtained from the suppliers of those products, their 

published announcements or other publicly available sources. IBM®  has not tested those products and 

cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM® 

products. Questions on the capabilities of non-IBM®  products should be addressed to the suppliers of 

those products.

Statements regarding IBM®'s future direction or intent are subject to change or withdrawal without notice, 

and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate 

them as completely as possible, the examples include the names of individuals, companies, brands, and 

products. All of these names are fictitious and any similarity to actual people or business enterprises is 

entirely coincidental.

COPYRIGHT LICENSE:
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This information contains sample application programs in source language, which illustrate programming 

techniques on various operating platforms. You may copy, modify, and distribute these sample programs 

in any form without payment to IBM®, for the purposes of developing, using, marketing or distributing 

application programs conforming to the application programming interface for the operating platform 

for which the sample programs are written. These examples have not been thoroughly tested under 

all conditions. IBM®, therefore, cannot guarantee or imply reliability, serviceability, or function of these 

programs. The sample programs are provided "AS IS", without warranty of any kind. IBM®  shall not be 

liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright 

notice as follows: 

© (your company name) (year). 

Portions of this code are derived from IBM Corp.  Sample Programs. 

© Copyright IBM Corp.  2000, 2017.

Trademarks
IBM®, the IBM®  logo, and ibm.com®  are trademarks or registered trademarks of International Business 

Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be 

trademarks of IBM®  or other companies. A current list of IBM®  trademarks is available on the web at 

"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM®  website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary 

notices are preserved. You may not distribute, display or make derivative work of these publications, or 

any portion thereof, without the express consent of IBM®.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all 

proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, 

http://www.ibm.com/legal/us/en/copytrade.shtml
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distribute or display these publications or any portion thereof outside your enterprise, without the express 

consent of IBM®.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either 

express or implied, to the publications or any information, data, software or other intellectual property 

contained therein.

IBM®  reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use 

of the publications is detrimental to its interest or, as determined by IBM®, the above instructions are not 

being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable 

laws and regulations, including all United States export laws and regulations.

IBM®  MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS 

ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, 

AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement
IBM Software products, including software as a service solutions, (Software Offerings) may use cookies 

or other technologies to collect product usage information, to help improve the end user experience, 

to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable 

information is collected by the Software Offerings. Some of our Software Offerings can help enable you 

to collect personally identifiable information. If this Software Offering uses cookies to collect personally 

identifiable information, specific information about this offering use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable 

information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect 

personally identifiable information from end users via cookies and other technologies, you should seek 

your own legal advice about any laws applicable to such data collection, including any requirements for 

notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, 

see IBM's Privacy Policy at http://www.ibm.com/privacy  and IBM's Online Privacy Statement at http://

www.ibm.com/privacy/details  in the section entitled Cookies, Web Beacons and Other Technologies, 

and the IBM Software Products and Software-as-a-Service Privacy Statement at http://www.ibm.com/

software/info/product-privacy.
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